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Welcome

The TFG4000 Professional Edition Software Series is a set of business management software
applications that offer the robust functionality of an advanced management tool, yet tailored
to meet the needs and budget of your growing business. Each TFG4000 Professional Edition
application is integrated with other TFG4000 Professional Edition applications to provide you
the optimum benefits of business management software.

TFG4000 Professional Edition is an easy-to-learn, user-friendly system that requires only
minimal keystrokes for entering information. There are customizable dropdowns, font sizes,
and screen colors available, as well as powerful search capabilities and built-in help features
to help guide you through the system. With TFG4000 Professional Edition, you have the
ability to pull up various summary screens, enter as little or as much data as you need,
process a variety of reports - all of which help you save both time and money, which will
add directly to your bottom line. For added convenience, TFG4000 Professional Edition also
allows you to run the system in either single or multi-user mode, whichever works best for
your business. Other features include optional security, as well as data import and export
features, which save you the work of re-keying information. In all, TFG4000 Professional
Edition is the smart source for business management. A simple solution for a complex
process.

System Requirements

Microsoft Windows XP®, Microsoft Windows 2003 Server®, or Microsoft Windows 2000
Server®, with the latest Service Pack applied.

Pentium® class processor, 1 ghz or greater.
100MB free disk space.
256MB of RAM (512MB or more recommended).

Network Interface Card configured to use TCP/IP if installing in multiple user mode (client /
server)



Starting TFG4000 Professional Edition

Perform the following steps to start TFG4000 Professional Edition in either Single or Multiple
User Mode:

Single User

1.

2.

3.

Open the “Start” menu, and then select the “Program” or “All Programs” option.
Select “TFG4000 Professional V1.4" from the program list.
Select “TFG4000 Professional Single V.1.4" to start.

The TFG4000 Professional Edition “Welcome” screen is displayed with the “Tip of
the Day”. You can select “Close” to continue the start up process or select “Next
Tip” to view more tips. You can also choose not to have the “Tip of the Day”
appear by selecting the check box next to “Don’t show Tip of the Day at Startup”
located on the Welcome screen. Select the check box again at any time to
reinstate the “Tip of the Day” feature.

If you see a “User” and “Password” field on your screen, enter the User ID and
Password that your System Administrator provided you, and either press “Enter”
or click “Sign On”.

If your screen only displays “Welcome” without any other fields, then click the
plus sign (“+”) next to the application you want to perform in the “NavTree”.

Click on the screen you would like to use.



Multiple Users (Not available in the Demo Version)

Server Startup

At installation, the server component is put in the Startup folder of the Program List.
It will automatically start at system start up. Perform this procedure only if

necessary.
1. Open the “Start” menu, and then select the “Program” or “All Programs” option.
2. Select “TFG4000 Professional V1.4” from the program list.

3. Select “TFG4000 Professional Server V1.4" to start.

4. The “TFG Web Server” screen is displayed. It will display the INI file and the

TCP/IP port number being used for the server. This window will display other
server messages as needed.

Client Startup

1.

2.

Open the “Start” menu, and then select the “Program” or “All Programs” option.
Select “TFG4000 Professional V1.4" from the program list.
Select “TFG4000 Professional Client V1.4" to start.

The TFG4000 Professional Edition “Welcome” screen is displayed with the “Tip of
the Day”. You can select “Close” to continue the start up process or select “Next
Tip” to view more tips. You can also choose not to have the “Tip of the Day”
appear by selecting the check box next to “Don’t show Tip of the Day at Startup”
located on the Welcome screen. Select the check box again at any time to
reinstate the “Tip of the Day” feature.

If you see a “User” and “Password” field on your screen, enter the User ID and
Password that your System Administrator provided you, and either press “Enter”
or click “Sign On”.

If your screen only displays “Welcome” without any other fields, click the plus ign
(“+) next to the application you want to perform in the “NavTree”.

Click on the screen you would like to use.



Built-in Help
Help is available at the screen, field, and column level, as well as built-in tool tips.

Screen Level Help

To select screen level help, click “Help” on the “Menu” bar, and then select “Screen Help”.
Help for the screen is then displayed.

Screen Help
" About

Field Level Help

To select field level help, right click on the field, and then click “Help” from the pop-up.
Help for the selected field is then displayed. You may also press the F1 key to get field
help.

Cut

Copy
Paste

Column Level Help

To select column level help, right click on the column heading, and then click “Help” from
the pop-up. Help for the selected column is then displayed.

Column Help




Tip of the Day

Each time you start TFG4000 Professional Edition, there is a “Tip of the Day” pop-up
displayed that describes some of the functionality that is available within the application. To
close the “Tip of the Day” pop-up, click the “Close” button. To view another tip, click the
“Next Tip” button. This feature can be turned off by clicking the box next to “Don’t Show Tip
of the Day at Startup” on the Welcome screen. A check mark will appear in the box
indicating the “Tip of the Day” should not be displayed during start up. To reinstate the “Tip
of the Day” feature, click the box and the check mark will disappear indicating the “Tip of
the Day” should be displayed during start up.

Example Only:

¥ TFG4000 Tip of the Day

TIP OF THE DAY

Did wou know you can change the size and position of the navigation tree?

There is a bar between the navigation tree and the rest of the screen. Position your
cursor over the bar until you see an arrow with two pomnts. Left click and while still
holding the mouse button dowern, move left or right to make the nawigation tree
farrower of wider,

To move the tree, click the "View" menu and select "Flip Tree Position". The tree will
be position on the right side of the screen. Repeat to move the tree back to the left side

of the screen.

To hide the tree completely, click the "Wiew" menu and select "Hide Navigation Tree".

e

Mext Tip

Tool Tips

Throughout TFG4000 Professional Edition, there are embedded tool tips that help describe
certain areas on the screen. You simply roll your mouse (cursor) over the area in question,
and a pop-up will describe that specific area. The tool tip pop-up will remain visible for a few
seconds, then it will disappear automatically.

Example Only:

Item Definiion Item Information | Item Sum mary] Price Sum mary]

Current ltem
.R?:; Delete
ltem/Part: v #h i - [=
Description: = £ ud =
P | [Identification of the ItermnPart ,2 - =
x
Wl QLI
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Using TFG4000 Professional Edition

You can navigate through the TFG4000 Professional Edition screens by using the “NavTree”,
the “Goto Screen” section of the “View Menu”, and the tabs on the top and bottom of the
screen. For easy use, the toolbar provides a variety of functions for you to choose from as
you use the TFG4000 Professional Edition applications. There are buttons located on the
toolbar that allow you to perform various functions from each screen, such as
opening/displaying data, saving data, etc. The “Menu” provides useful functions as well,
such as printing reports, documentation, help, etc.

Sample Screen

T 1FGA0/ iemDetail

Actio
| imm| o
q
1‘FG e Item Definiton | tem Enformation] fterm Zommary| Frice Summary|
ot My Tree Curtmen R
i $[:Menw ItemiPart: ¥{Bo0RCASE, 48° pe: [azsembly Bl
» Bill of Materiats Deserig 48" Hooden [fach )
» Inveniory Control Product Group: |active B
# J Process/Job Order
&= B® Systern Acministration
¥ Ukser Control S
b Location Control
¥ Drepdown Conlrol Number: [ac-127 Sales: Sales Item ¥
¥ System Verisbles Commodity: [Rockcase ttem Level:  [Aon
¥ Database Definitiors
* Serial Mumbsrs
» Utility Contral N
* Welcome _
Gross: DiscountPercent: "
Discount: | ttem Cost: 20.000
—
Net:

Message:  |Next Record Loaded

s ltem Defiritin Bl ONgatieials Invertory |
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Menus

Each screen in TFG4000 Professional Edition has various menus available for working with
your data. The following describes the purpose of each menu and special features.

Action

This menu is for printing screens and for exiting TFG4000 Professional Edition. It contains
the following menu items:

Print Prints the entire screen in either portrait or landscape
mode.
Print Text Prints only the text currently displayed on the screen in

either portrait or landscape mode.
Exit Terminates the TFG4000 Professional Edition session.
Edit

This menu is for performing cut, copy, and paste operations on data. It contains the
following menu items:

Cut When you highlight data and use this function, the data
is removed from the screen and is available in a
clipboard for pasting. Holding the “Ctrl” key and
pressing the “X” key will perform the same operation.

Copy When you highlight data and use this function, the data
is copied into a clipboard and is available for pasting.
Holding the “Ctrl” key and pressing the “C” key will
perform the same operation.

Paste When you position your cursor in a field and use this
function, data you have previously put into the clipboard
using the “Cut” or “Copy” operation will be pasted after
your cursor. Holding the “Ctrl” key and pressing the “V”
key will perform the same operation.

Note: If your keyboard is in “insert mode” the data will not overlay data that

follows, but if it is not in “insert mode” it will. Press the Insert key on your
keyboard to change your insert mode to whichever way you prefer.

12



View

This menu allows you to change the way the TFG4000 Professional Edition screens are
presented and how you navigate the screens. It contains the following menu items:

Set Font Size

Hide Calendar Buttons

Flip Tree Position

Hide Navigation Tree

Allow Word Wrap

GoTo Screen

You can choose a font size from 10 to 18. With larger
font sizes you may have to scroll to see the entire
screen.

Toggles whether or not a Calendar button is displayed
next to the date fields.

Changes the position of the “NavTree” to either the left
or the right side of the screen.

Hides the “NavTree” from the screen. Click it a second
time to display the “NavTree” on the screen.

Note: The dark arrows in the bar between the NavTree”
and the main screen perform the same function.

Determines how text may be viewed. When it is
checked, text may be displayed on multiple lines and
can be viewed by scrolling up and down. When it is not
checked, text may be viewed by scrolling right and left.
Word wrap is allowed only if the system variable
Allow_Wrap is set to Yes.

Displays the “NavTree” in menu format. You can use
this method to navigate the screens at any time but it is
particularly useful if you hide the “NavTree”.

View Documenta

Set Font Size 4
Hide Calendar Buttons
Flip Tree Position

Hide Navigation Tree

Process/Job Order »  Bill of Materials
System Administration »  Inventory Control

13



Reports

This menu shows you the reports or forms available for the screen you are on. There will be
various menu items depending on the screen. There is also an “All Reports” menu available
from any screen.

Note: Forms are structured documents such as Invoices, Packing Slips, Purchase Orders,
etc. Though you will see forms in the Reports menu on some screens, you will not
see forms in the All Reports menus.

Specific Reports Displays reports associated with the screen you are on.

All Reports Displays a menu of reports available for all the
applications you have installed. This menu does not
include Forms.

Reports Documentation Help

Inventory Management »

S Process/Job Order '
Sales Orders ’
Material Scheduling '

DI Gl GE G = =0 e8] Purchasing Item Summary Report

Warehiousiry *  Purchase Order Hislory Reporl
Preventive Maintenance »  Pirchase Order Summary Repaort
Common Applications »  Suppller Statlstics Report

System Administration »  Supplier Summary Report

Documentation

This menu lets you select the TFG4000 Professional Edition manuals for viewing and
printing.

Help

This menu provides help about the screen you are on and information about TFG4000
Professional Edition. It contains the following menu items:

Screen Help Displays information about the screen you are on.
About Displays information about TFG4000 Professional
Edition.

14



Buttons & Icons

Each screen in TFG4000 Professional Edition has various buttons available for working with
your data. The following describes the purpose of each button and special features. It also
explains other icons you may see on the screens.

|4 [FHE x « » &

Toolbar Buttons < | & B | » o

Use the following buttons to perform TFG4000 Professional Edition application tasks. The
buttons displayed change with the screen you are working with.

Previous screens ©

Use this button to return to your previous screen. You can go back up to ten screens.
Cutting, copying and pasting text| # & &

You can use “Cut” and “Paste” to move selected text. You can use “Copy” and “Paste” to

copy selected text and paste the copy in another place. “Cut”, “Copy”, and “Paste” can also
be selected from the “Edit” menu.

Working with data R H X 4« » &
You can perform many different operations by using these buttons:

& Erase This button clears data from the screen. It does not
update any data; it merely clears the data away to make
it easier for you to enter something else. It is
particularly useful for resetting summary screens for a
new search and it may be required when adding new
entries on some screens.

& Open (Display) This button retrieves data that has been previously
saved for viewing and/or modifying. The Enter key
executes this button by default.

H save This button stores new data and modified data. If you
enter new data or change existing data and do not click
this button, the system prompts you to do so.

D) Cancel This button reduces any remaining quantities to zero
and changes statuses to “Cancelled”.

X Delete This button deletes previously saved data. On screens
indicated as “definition” screens, the delete button
deletes related data in addition to the data currently
displayed. On all other screens only the data displayed is
deleted.

4 Previous This button retrieves data that alphabetically precedes
the currently displayed data.

15



P Next

EZ2 copy

= Print

" Build

&3 Refresh

Split

Screen Buttons

This button retrieves data that alphabetically follows the
currently displayed data.

This button copies data from one place to another. It
can copy related data in addition to the data currently
displayed.

This button sends your document to the printer to be
printed.

This button extracts eligible data from one place to
create a new definition in another place. For example, it
can extract customer order data to build a new invoice.

This button rebuilds the data on the screen.

This button will take lines from one document to create
a new document using the lines selected.

Throughout the screens are buttons that perform functions.

#% search

B Calendar

¥ Dropdown

Table Buttons
Throughout the tables are buttons

Bl GoTo/Selection

This button is for finding data you have already entered.
When you click this button a search box pops up.

This button provides a pop-up calendar for selecting
dates. You can choose the month and the year, and
then double-click on the date you desire. Click “Today”
to re-position the calendar on the current date. Click
“Cancel” if you decide not to select a date. Dates can be
entered without using the “Calendar” button if desired.
Manually entered dates are verified so a pop-up appears
prompting you to correct a date if it is invalid.

This button provides a “dropdown” list of pre-defined
values from various fields that have this button next to
it. If you click on one of the values from the dropdown
list, that value will appear in the adjacent field.

that perform functions.

This button is for either transferring to another screen or
selecting data. When you right-click on this button, it
displays a menu of related screens and/or a menu of
selection activities. To transfer to another screen, click
on the screen you desire and that screen is displayed
with the appropriate keys already filled in. To select
data, such as a component or inventory location, click
the action you want.

Goto Item Definition

Goto Bill of Materials Definition

16



 Properties

= Add Rows

¢ Scroll to the Left
» Scroll to the Right
“« Scroll Up

¥ Scroll Down

¥ Scroll Bottom

X Scroll Top

M Scroll Left

M Scroll Right

Information lcons

This button is located at the lower left corner of each
table. It allows you to edit the layout of the table. You
can use this button to hide or display columns in the
table and to restore the original table layout.

This button appears in the lower right corner of
modifiable tables so that you can put more empty rows
on the screen for adding data to the table. If you are
trying to enter another row in a table and there are not
any blank rows to use, click the “Add Rows” button.
This button allows you to scroll to the left of the table.
This button allows you to scroll to the right of the table.
This button allows you to scroll up the table.

This button allows you to scroll down the table.

This button allows you to scroll to the very bottom of the
table.

This button allows you to scroll to the very top of the
table.

This button allows you to scroll to the very left of the
table.

This button allows you to scroll to the very right of the
table.

Icons on the screen show properties about the field.

* Numeric

T Key

v Required

This icon in the upper left corner of a field indicates that
the field is for a numeric value. You are able to enter
only numbers, commas, and decimals in fields
containing this icon.

This icon to the left of a field indicates that the field is a
key field and is required for this screen.

If you try to display or save data without entering a

required field, this checkmark icon is displayed next to
the missing field.

17



Field Colors

The fields on the screens and in screen tables have three different colors that have
functional significance.

Gray A gray field is display only, no entry allowed or necessary
White A white field is open for entering data
Yellow A yellow field indicates where the cursor is currently positioned

Changing Screen Table Properties

Tables that appear on screens can be modified. The columns can be re-sized, re-positioned,
hidden, and un-hidden.

To re-size a column move your cursor over the column heading you want to re-size and
move to the right until you see an arrow with two heads. Click, then still holding the mouse
button down, move the cursor to the right until the column is as wide as you want or to the
left until the column is as small as you want.

To re-position a column click on the column heading, then still holding the mouse down,
move the column to the where you want it and release the mouse. Some columns are key
columns and will not remain where you re-position them.

Note: Re-sizing and re-positioning remain in effect for the duration of the current session.
The default sizing and positioning is restored when TFG4000 Professional Edition is
restarted.

To hide or unhide a column click the Properties button = located in the lower left corner of
the table. A red check mark next to the column name indicates the column will be
displayed. If there is not red check mark next to the column name it will not be displayed in
the table. There may be multiple tabs for the table, so you must click on the tab that
contains the column(s) you want. To save the changes you have made, click the “OK”
button. To discard the changes you have made, click the “Cancel” button. To reset the
properties back to the default properties, click the “Restore Default Visibility” button.
Another pop-up will appear asking the range you wish to restore. Use the dropdown
provided to select either “All Tabs”, which will restore the defaults for the entire table, or
“Currently Displayed Tab Only”, which will restore the default properties only for the portion
of the table indicated by the tab you are viewing. Once you have made your selection click
“OK” or “Cancel”. That pop-up will disappear and the column visibility properties are reset
as requested or the reset action is cancelled. Then you may click either “OK” or “Cancel” to
save or discard the property changes.

Note: Property changes remain in effect even after TFG4000 Professional Edition is
restarted.

18



Performing Searches

There are two types of searches in TFG4000 Professional Edition that are similar in
appearance, however they have different functionality. The first is a “Search” associated
with a field on the screen. The second is a “Search Pop-up” which is found on tables. One
of the differences between the two is that a “Search Pop-up” can load multiple table rows to
the screen at one time but a “Search” will not. Another difference is that “Search” screen
results can be printed but “Search Pop-up” results cannot.

Search Screen (Fields)

Below is an example of a search screen that may be used to locate information already
entered into the system, and/or to automatically populate the fields on the screen that you
are currently viewing or editing. When search results are displayed you can move the
columns into different places on the search screen so that the values can be viewed in
positions different from the default layout. Click the heading of the column you wish to
move then drag and drop it into the desired position. Resize columns by moving the cursor
over the heading until you see an arrow with two heads. Click, and with the mouse button
still down, move the cursor right or left until the column is the desired width. The default
layout is restored when the “Search” button is pressed and when you exit the search. In
addition, you also have the option to retain search parameters by checking the box located
next to “Retain Search Parameters”. This option allows you to save the search parameters
you used for future searches.

Example Only:

= Search El
Search for item Numbers
Daouble-Click Search Results to Load Data to Screen
Search Criteria
Max Rows To Display: 30 I~ Retain These Search Parameters
Find Item MNumbers [starting with |[sockcase

S concel | et |

ftemiPart Description Type Unit of Measure
BOOKCASE, 48" 45" Wooden Bookcase Assembly Each
BOOKCASE, 60" B0 Wooden Bookcase Assembly Each
BOOKCASE, 84" &4" Wooden Bookcase Assembly Each

3 records found
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Using the Search Screen

1.

2.

5.

6.

Click the Search button #4 located directly next to the field you want to search.

Enter the maximum number of rows of data you want to display in your results.
The default is “30”.

Select one of the search choices using the dropdown. The default is “starting
with”.

Enter all or part of the value you want to search with. You may leave the search
field blank to return all applicable records in the database. If there is a value in
the screen field you are searching on, it will be copied to the search field. You
can change the search field value on the “Search” screen.

Click the Search button #4.

Double click on the row you desire to load the information to the main screen.

Modifying the View of the Search Results

To modify the view of the search results, do the following:

1.

To re-size a column move your cursor over the column heading you want to re-
size and move to the right until you see an arrow with two heads. Click, then still
holding the mouse button down, move the cursor to the right until the column is
as wide as you want or to the left until the column is as small as you want.

To re-position a column click on the column heading, then still holding the mouse
button down, move the column to where you want it and release the mouse.
Some columns are key columns and will not remain where you re-position them.

To re-size the window move your cursor over the edges of the window until you
see an arrow with two heads. Click, and then still holding the mouse button
down, move the cursor to increase or decrease the size of the window.

Printing the Search Results

To print the search results, use these steps:

1.

2.

Click the Print button = on the “Search” screen.

Type or select the appropriate formatting options in the dialog box and then click
“OK” to print the report.
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Search Pop-Up Screen (Tables)

Below is an example of a search pop-up screen that may be used to populate columns in the
table on the screen that you are currently viewing or editing. When search results are
displayed you can move the columns into different places on the search pop-up screen so
that the values can be viewed in positions different from the default layout. Click the
heading of the column you wish to move then drag and drop it into the desired position.
Resize columns by moving the cursor over the heading until you see an arrow with two
heads. Click, and with the mouse button still down, move the cursor right or left until the
column is the desired width. The default layout is restored when the “Do Search” button is
pressed and when you exit the search pop-up.

Example Only:

Search Criteria

Max Rows To Display: 30
Find values [starting with | |Bookease

Cancel

ftemPart Description Unit of Measure Type
BOCHCASE, 458" 45" Wooden Bookcase Each Aszembly
BOCHCASE, 60" G0" Wooden Bookcase Each Aszzembly
BOCOKCASE, 84" 24" Wooden Bookcaze Each Aszzembly

Select Al ‘ cancel ‘

3 records found
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Using the Search Pop-Up Screen

1.

2.

Click the GoTo/Selection button &l in the row you want to search.

Enter the maximum number of rows of data you want to display in your results.
The default is “30”.

Select one of the search choices using the dropdown. The default is “starting
with”.

Enter all or part of the value you want to search with. You may leave the search
field blank to return all applicable records in the database.

Click the “Do Search” button.

To select just one entry, double-click on it to populate the fields on your screen.
To select more than one entry, hold down the “Control” key while you click on the
other selections with your mouse, then click “Load to Screen” to populate the

information.

To load all of the entries to the screen table, click the “Select All” button and then
click the “Load to Screen” button.

Modifying the View of the Search Results

To modify the view of the search results, do the following:

1.

To re-size a column move your cursor over the column heading you want to re-
size and move to the right until you see an arrow with two heads. Click, then still
holding the mouse button down, move the cursor to the right until the column is
as wide as you want or to the left until the column is as small as you want.

To re-position a column click on the column heading, then still holding the mouse
button down, move the column to where you want it and release the mouse.
Some columns are key columns and will not remain where you re-position them.

To re-size the window move your cursor over the edges of the window until you
see an arrow with two heads. Click, and then still holding the mouse button
down, move the cursor to increase or decrease the size of the window.

Printing the Search Results

To print the search results, use these steps:

1.

2.

Click the Print button =1 on the “Search” screen.

Type or select the appropriate formatting options in the dialog box and then click
“OK” to print the report.
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Working with Reports

You can view, modify, and print reports by using the “Reports” menu located just above the
toolbar.

To view a report, follow these steps:

1. Click on “Reports” above the toolbar. A menu will drop down indicating which
reports can be generated from that screen and a selection for All Reports. Click
on the report name that you want.

2. A status window will appear showing that the system is generating the report.

3. You will then see your report displayed on the screen.

To modify and/or print a report, follow these steps:

1. Click on “Reports” above the toolbar. A menu will drop down indicating which
reports can be generated from that screen. Click on the report name that you
want.

2. A status window will appear showing that the system is generating the report.

3. You will then see your report displayed on the screen with this toolbar at the

top:

Frinting Options Fage Setup IWemarize ‘ Frint ‘ Freview ‘ Excel ‘ Revert ‘ Help ‘ Close

Printing Options Allows you to set the Page Number Prefix, number of
pages wide, and the Repeat Section Header/Footer
settings. Adjust the settings to your specifications and
then click “OK”.

Page Setup Allows you to adjust page settings such as page
orientation and margins. Once finished adjusting the
settings, click “OK”.

Memorize Allows you to save report settings under a report that
you name yourself so you can run the report again with
the same settings. You can save settings for a report
under different names so you can have multiple versions
of the same report formatted different ways. The new
report names appear in the Report menu at the top of
the main screen (after you go to another screen and
come back) and they are available only to you, other
users will not be able to see reports you memorized.

Print Allows you to select printer settings and print your
report. Once finished with settings, click “OK” to print
the report.

Preview Allows you to preview your report layout before you
actually print. Once finished previewing, click “Close”.
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Excel Allows you to save your report as an Excel document.
Once finished naming and specifying where to save your
report, click “Save”.

Revert Allows you to discard all layout changes and revert to
default settings. Simply click either “Yes”, or “No”.

Help Shows the Report Layout Instruction screen.

Close Click this button to close the report and return to the
main screen.

In some reports the selection criteria can be changed in the report window. Adjust the
selection criteria as desired, and then click the “Refresh” button to reload the data. When
you exit the report you will be asked if you want to update the screen with the refreshed
data from the report. Click “Yes” to update the screen or “No” to leave the screen as it was
when you started the report.

Report layouts can be modified. Columns can be re-sized, hidden, and un-hidden and
sections can be hidden and un-hidden.

To re-size a column do the following:
1. Move your cursor over the column heading you want to re-size.
2. Move to the right until you see an arrow with two heads.
3. Click, then still holding the mouse button down, move the cursor to the right until
the column is as wide as you want or to the left until the column is as small as
you want.

To hide or unhide a column, do the following:

1. Right click in the report area or the long, thin “Edit” button on the left side of the
report window to get the “Report Layout Options” window.

2. Click the “Column Visibility” tab. A red check mark next to the column name
indicates the column will be displayed. If there is not red check mark next to the
column name it will not be displayed in the report.

To hide or unhide a report section, do the following:

1. Click the tab for the section you want to hide or unhide.

2. Right click in the report area or the long, thin “Edit” button on the left side of the
report window to get the “Report Layout Options” window.

3. Click “Do Not Print This Section”.

To save the changes you have made, click the “OK” button. To discard the changes you
have made, click the “Cancel” button.

To reset the properties back to the default properties, click the “Revert” button located on
the report toolbar. A dialog box will appear asking if you want to discard changes and revert
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back to default settings. Click either “Yes” to restore the defaults or “No” to keep the
changes.

Note: Report layout changes remain in effect even after TFG4000 Professional Edition is re-
started.

Logos on Forms and Reports

Special forms such as job order forms, customer order forms, packing slips, invoices, and
purchase order forms have an area for a company logo. The logo is controlled by system
variable Form_Logo.

Reports have an area for a company logo too. The logo is controlled by system variable
Report_Logo.

See the System Administration Users Guide for more information about these system
variables and how to set them.

Working with Summary Screens and Summary Reports

TFG4000 has many summary screens and reports available for locating data, listing data,
and summarizing data. Each summary screen and report has various fields for search
criteria that are used in combination with one another. The search criteria fields can use
wildcards and other sophisticated SQL search techniques. For more information about
wildcard characters that can be used for advanced searching, refer to the following Microsoft
website:

http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/off2000/html/acconWildcardCharactersS.asp

Due to differences between Access and ANSI wildcard characters, when reading this website
and using wildcards in TFG4000, substitute as follows:

% for *
_for?
# is not used

Also note that these wildcards cannot be used in searches.
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Initial Setup

Email and Instant Messages

The TFG4000 Order Point feature has the ability to send an email, an instant message, or
both to notify someone when an order point has been reached. Before email or instant
messages can be sent, there are some system administration setup requirements. See the
System Administration Users Guide for more information about configuring TFG4000 for
email and instant messages.

System Variables

TFG4000 Inventory Management is installed with certain features that can be changed. The
features are controlled with system variables. There are several system variables you need
to understand before you start using Inventory Management. See the System Variables
screen in the System Administration User Guide for more information about changing the
settings for system variables. The System Administration User Guide is available from the
Windows “Start” menu or from the “Documentation” menu within TFG4000.

Allow__Negative_Inventory (installation default is “No”) -— With this variable set to “No”,
on hand inventory balance cannot be negative. An inventory transaction that would cause
the on hand balance to go negative will be rejected as error. With this variable set to “Yes”,
on hand inventory balance can be negative. No inventory transactions will be rejected.

Order_Point_Email (installation default is blank) — Order Point processing will send email
notification when the order point for an item has been reached. Normally the notification
would be sent to the order point email address on the Order Point Item screen for the item,
but if no email address was defined for the item, the system will send the notification to the
default email address defined with the Order_Point_Email system variable. If you do not
want a notification sent to a default email address, leave this variable blank.

Order_Point_IM (installation default is blank) — Order Point processing will send instant
messenger notification when the order point for an item has been reached. Normally the
notification would be sent to the order point IM address on the Order Point Item screen for
the item, but if no IM address was defined for the item, the system will send the notification
to the default IM address defined with the Order_Point_IM system variable. If you do not
want a notification sent to a default IM address, leave this variable blank.

User_Image_Directory (installation default is “Userlmages”) — This variable indicates
where pictures of items are stored. The default directory is located under the “Server”
directory where you installed TFG4000. If you want to store images elsewhere you must
change this variable and include the full directory path. Please make sure the path is
accessible to anyone who needs to view item images.

Inventory_Cost (installation default is “Current Cost”) — With this variable set to
“Current Cost”, inventory cost is calculated using the total inventory cost entered for an
item on the Item Definition screen under Shared Applications. When the inventory cost on
the Item Definition screen is changed the total inventory cost is recalculated using the new
value. With this variable set to “Average Cost”, inventory cost is calculated using the
average cost of the item. The average cost is calculated each time inventory is received,
cycle counted, or adjusted. The average cost is calculated as follows (using a receipt for the
example):
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Average Cost = Current Inventory Cost
The initial average cost is the same as the Inventory Cost entered on the Item
Definition screen under Shared Applications.

Old Value = On Hand x Average Cost
When a receipt is processed, the value before the receipt is calculated

Receipt Value = Receipt Quantity < Current Inventory Cost
The receipt value is calculated using the current Inventory Cost on the Item
Definition screen under Shared Applications

New Value = Old Value + Receipt Value
The new value of on-hand inventory is calculated by adding the old value and the
receipt value together

New On-Hand = Old On-Hand + Receipt Quantity
The new on-hand inventory is calculated by adding the old on-hand and the
receipt quantity together

New Average Cost = New Value +~ New On-Hand
The new average cost is calculated by dividing the new value by the new on-hand

The system requires all inventory locations be predefined. If you want to use warehouse and
zone as part of the inventory location you must define them first.

To set up your Warehouses, perform the following:

1.

3.

4.

Click the plus (“+™) next to “Shared Applications” or double-click # «shared
Applications” in the “NavTree”.

Click “Warehouse”.

Enter the warehouse information.

Once finished, click the Save button E located on the toolbar.

To set up your Zones, perform the following:

1.

Click the plus (“+™) next to “Shared Applications” or double-click # «shared
Applications” in the “NavTree”.

Click “Zone”.

Enter the zone information (zones are defined within warehouses so you must
define at least one warehouse before you can define a zone).

Once finished, click the Save button = located on the toolbar.
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To set up your Inventory Locations, perform the following:

1. Click the plus (“+”) next to “Shared Applications” or double-click # «shared
Applications” in the “NavTree”.

2. Click “Location”.

3. Enter the location information (locations are defined within warehouses and
zones so if you want to define your locations with warehouses you must define at
least one warehouse before you can define a location. Zones are optional but if
you want a location within a zone you must define the zone within a warehouse
first, then you can define the location within the zone).

4. Once finished, click the Save button [H 1ocated on the toolbar.
There is also a screen called Generation you can use to generate multiple locations at a

time. See the Shared Applications Users Guide for more information about the location
Generation screen.
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Bill of Materials

What is a Bill of Materials?

A Bill of Materials (BOM) is a series of individual items that are grouped together to create a
larger item defined by a specific identifier. It is a list of what is required to produce a
physical product or perform a service. For a physical product it can be as simple as a list of
the ingredients for a cake or as complex as the list of parts needed to build a computer. For
a service it can be as simple as the supplies and services necessary to cater a birthday party
or as complex as the tools, supplies, and services needed to maintain an office building.

Bills of material are connected by ‘links.” Each component is stand-alone and can be used in
multiple places. Pointers or links are used to connect items to create a bill of materials.
Essentially, it means you only have to maintain a component once in the database.

Note: For an item with components, i.e. an item that has a bill of materials defined for it,
inventory transactions do not affect the components. For example, if an item called
ITEM1 has a bill of materials with five other items as components and a Ship
transaction is performed for ITEM1, inventory for ITEM1 will be affected but none of
the inventory for any of its components will be affected.

To process inventory for components you must enter inventory transactions for each
component or use the TFG4000 Job Order Management application. See the Item
Inventory section in this manual for more information about using job orders to
update bill of materials component inventory.
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Defining a Multi-Level Bill of Materials (BOM)

The following describes the steps to define a BOM that has several levels of components.

Physical Product

For a physical product, an assembly is a collection of parts and/or subassemblies that are
put together. A subassembly is an assembly that is used at a higher level to make up
another assembly. Each assembly and subassembly is given a unique identifier.

Subassemblies and parts are generally categorized together as components, and may be
produced in the same place as the finished product or purchased from vendors.

A BOM is a listing of all components that go into an assembled product showing the quantity
of each required to make one assembly.

The following figure shows a multi-level product tree with subassemblies Z and Q. Q is
assembled from Items 1 and 4, and Z is assembled from subassembly Q and Item 2.
Product X is the final assembly of subassembly Z and Items 3 and 5.

Ilulti-Lewel Procuct Tree

X Level 0
|
z @ Level 1
|
I
Q Level 2

O O

In this example we could be building a bird house where Q is the roof assembly composed
of Item 1 (wood) and Item 2 (glue). Z is the house assembly that contains the roof
assembly Q and Item 2 (wood for bottom and sides). Finally, Z is used on the finished bird
house with item 3 (decorative trim) and Item 5 (birdhouse stand). Perhaps Item 5 is an
assembly that is purchased already assembled so it would not have a bill of materials like Q
and Z that we assemble ourselves.
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Service

For a service, an assembly is a collection of services, materials, and/or subassemblies that
are needed to complete the service. A subassembly is an assembly that is used at a higher
level to make up another assembly. Each assembly and subassembly is given a unique
identifier.

Subassemblies and parts are generally categorized together as components.

A BOM is a listing of all components that go into a service showing the quantity of each
required to complete the service.

The following figure shows a multi-level service tree with subassemblies Z and Q. Q is a
subassembly that uses Items 1 and 4, and Z consists of Q and Item 2. Service X is the final
assembly consisting of Z and Items 3 and 5.

Ihalti -Lewel Setwice Tree
X Lavel
NGRS
|
Q Levwel 2
|
Lavwel 5

An example of this could be in a catering business where Q is a set of utensils containing
Item 1, which is a plastic fork and Item 4 that is a plastic knife. Z could be a basic catering
package that includes the utensil set Q and Item 2, which is a cake. X could be a birthday
party package that includes the basic catering package Z, as well as Item 3, which is a
balloon, and Item 5, which is a clown.
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Bill of Materials Screens

Bill of Materials consists of five tabbed screens that are used to enter, maintain, and view
BOM data. Each screen is used for specific purposes to aid in the maintenance of BOM's.

Bill of Materials (BOM)

Use this screen to create the structure of the BOM. A structure can be created from the top
down, starting with the highest level item identified in the “Item/Part” field. Items that
make up the structure are then entered into the table with all relevant data. You can also
create the structure by starting with the lowest level in the BOM, and enter the items for
that level in the table building from the bottom up.

Once you have created a BOM structure, you can use this screen to maintain the BOM
structure.

The BOM structure is displayed in a “tree” format on the left side of the screen (select the
“Tree” tab at the bottom of the display). You can select items in the tree to display the item
components that make up that item, if any.

Explosion

Use this screen to display the item components from which an item is composed. You can
display the data in two different views:

Single Explosion Shows the first level components from which an item is
composed.
Indented Explosion Shows the components at all levels from which an item

is composed.
Where Used

Use this screen to display where items are used in bills of material (BOM’s). You can display
the data in two different views:

Single Where Used Shows the items that use this component directly.

Indented Where Used Shows all the items (by level) that use this component
either directly or indirectly through other items.

Summary

Use this screen to display the item components only once, with the quantity required for the
number of units you specify. You can display the data in two different views:

Summarized Explosion Shows all of the item components from which
this item is composed.

Summarized Where Used Shows all of the items where this component is
used.

Cost
Use this screen to display an indented explosion with individual component costs.
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Bill of Materials Screens Explained

Bill of Materials (BOM) Screen

Use this screen to create the structure of the BOM. A structure can represent a product that
is manufactured or a service.

Once you have created a BOM structure, you can use this screen to maintain the BOM
structure.

The BOM structure is displayed in a “tree” format on the left side of the screen (select the
“Trees” tab at the bottom of the display). Click any of the items in the tree to display the
item components that make up that item, if any.

Note: For an item with components, i.e. an item that has a bill of materials defined for it,
inventory transactions do not affect the components. For example, if an item called
ITEM1 has a bill of materials with five other items as components and a Ship
transaction is performed for ITEM1, inventory for ITEM1 will be affected but none of
the inventory for any of its components will be affected.

To process inventory for components you must enter inventory transactions for each
component or use the TFG4000 Job Order Management application.

Current Item Group

Field Explanation
Item/Part A unique identifier assigned to each item. It is the main

key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

Type The type helps further define an item by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Description Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Unit of Measure Defines how the item is counted or measured. Some
examples of units of measure are "Ounce", "Pound", and
“Hour".

Revision Level Most current revision level for this item.

33



Component Table (Components, Description, Change Control, and Reference Designator

tabs)
Column
Row

Prefix

Component

Suffix

Quantity

Unit of Measure

Component Type

Delete

Description

Manufacture Status

Engineering Status

Change Order

Engineering Revision

Start Date

Explanation

The line number of the row in the table.

Unique identification of a component in this Bill of
Materials. The Prefix may be used to sequence the
component within the Bill of Materials or to allow
multiple entries for the same component.

Unique identification of an item that is a component of
another item on a Bill of Materials. This component
identification can be pre-defined using Item Definition
screens, but it is not a requirement that the component
be pre-defined.

Unique identification of a component in this Bill of
Materials. The Suffix may be used to sequence the
component within the Bill of Materials or to allow
multiple entries for the same component.

This field is the quantity required for one unit of the
parent Item/Part.

Defines how the item is counted or measured. Some
examples of units of measure are "Bag", "Carton", and
“Feet".

Information indicating what type of component this is.
Some examples of component types are “Assembly”,
“Industrial Supplies”, and “Tool”.

This is a checkbox to indicate you want to delete a
component from the bill of material.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Status of the Manufacturing Bill of Material for the
component, either Active or Inactive.

Status of the Engineering Bill of Material for the
component, either Active or Inactive.

Most current engineering change number for this item.
User entered for informational only.

Most current engineering revision level for this item.
User entered for informational only.

Date this component will become effective on this bill of
material.
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End Date

Reference Designator

Message Line

The last date this component will be effective on this bill
of material.

Indicates where this component is used on the parent
item. For example, it can refer to a number or letter on
a diagram or it can be the name of a component on a
printed circuit board. You can enter multiple reference
designators separated by commas in this field.

Explanation

Displays information about the current status of the
screen including error messages.

Accessing the Bill of Material Screen

1. Click the plus (“+") next to “Inventory” or double-click % “Inventory” in the

“NavTree”.

_O r_

Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.

2. Click “Bill of Material”. The “Bill of Material” screen is displayed.

3. If there is an item or part number in the “Item/Part” field, the bill of material for
that item or part number is displayed on the main screen.
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Using the Bill of Materials (BOM) Screen

Use these procedures to erase the screen, display, update, add, delete, display previous,
display next, and copy bill of material structures.

Creating a Bill of Materials (BOM)

Use this screen to create the structure of a bill of materials. A bill of materials may be
comprised of a series of items that are grouped together to create a larger item or service.

A structure can be created from the top down starting with the highest level item identified

in the “lItem/Part” field. Items that make up the product structure are then entered into the

table with all relevant data. You can also build the structure by starting with the lowest level

in the bill of materials and enter the items for that level in the table building bottom up.

For your convenience, there is a “tree” that appears on the left hand side of the BOM screen

SO you can see the product structure as you build it. To view the application tree instead,

click on the tab at the bottom that reads “NavTree”.

Note: For an item with components, i.e. an item that has a bill of materials defined for it,
inventory transactions do not affect the components. For example, if an item called
ITEM1 has a bill of materials with five other items as components and a Ship
transaction is performed for ITEM1, inventory for ITEM1 will be affected but none of
the inventory for any of its components will be affected.
To process inventory for components you must enter inventory transactions for each
component or use the TFG4000 Job Order Management application. See the Item
Inventory section in this manual for more information about using job orders to
update bill of materials component inventory.

Erasing the Screen

To erase the data from the screen click the Erase button .é located on the toolbar.

Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the
screen in preparation for another operation.

Displaying a Bill of Materials
To display a bill of materials, perform the following steps:
1. Enter an item or part number in the “ltem/Part” field.
2. Click the Open (Display) button & located on the toolbar or hit the Enter key.
3. The bill of materials is displayed on the main screen.
—or-

1. Use the Search button #4 next to the “Item/Part” field, the “Description” field to
select an item number.

2. Double-click on the “lItem/Part” you would like to display in the “Search” screen
table.
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3. The bill of materials is displayed on the main screen.
Updating a Bill of Materials
To update a bill of materials, perform the following steps:

1. Display the bill of materials you wish to change. See “Displaying a Bill of
Materials” above.

2. In the Component table, change, enter, or select the desired information. To add
a component you can right click and use the Goto/Selection button ] to select
an item. The “Description”, “Unit of Measure”, and “Component Type” columns
are filled in when you select an item. Component “Quantity” defaults to 1 if you
leave it blank. An item does not have to be pre-defined to be used as a
component. If the item is not defined you will be given the opportunity to add it
with an automatic “quick add” feature.

_Or_

To delete a component from the bill of materials, click the checkbox " in the
“Delete” column of the component table.

3. When done, click the Save button [E iocated on the toolbar.
Adding a New Bill of Materials
To add a new bill of materials, perform the following steps:

1. Display the item for which you wish to build a new bill of materials. See
“Displaying a Bill of Materials” above.

2. In the Component table, enter or select the desired information. You can right
click the Goto/Selection button & to select an item. The “Description”, “Unit of
Measure”, and “Component Type” columns are filled in when you select an item.
Component “Quantity” defaults to 1 if you leave it blank. An item does not have

to be pre-defined to be used as a component. If an item does not exist you will
be given the opportunity to add it with an automatic “quick add” feature.

3. When done, click the Save button [E 1ocated on the toolbar.
Deleting a Bill of Materials
To delete a bill of materials, perform the following steps:

1. Display the bill of materials you wish to delete. See “Displaying a Bill of
Materials” above.

2. Click the Delete button X located on the toolbar.

3. Click the “Yes” button on the “Confirm Action” pop up message. If you do not
want to delete the bill of materials, click “No” on the “Confirm Action” pop up
message.

Note: Once a bill of materials is deleted, it can no longer be displayed or updated.
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Displaying the Previous Bill of Materials

To display the bill of materials that precedes the bill of materials currently displayed,
perform the following steps:

1. Click the Previous button % located on the toolbar.
2. The previous bill of materials is displayed on the main screen.
Displaying the Next Bill of Materials

To display the bill of materials that follows the bill of materials currently displayed, perform
the following steps:

1. Click the Next button * located on the toolbar.

2. The next bill of materials is displayed on the main screen.

Tip: You can use the Next button ¥ as a convenient way to locate the first record
in the database. Start by erasing the screen using the Erase button .Gf, then
click the Next button ! .

Copying a Bill of Materials

Use this procedure to copy a bill of materials from one item to another. The item to which
you are copying the bill of materials (the target item) must be defined in “lItem Definition”
under Shared Applications before a copy can be performed.

1. Display the bill of materials you wish to copy. See “Displaying a Bill of Materials
above.

2. Click the copy button £ Jocated on the toolbar. A pop-up will appear.
3. Enter the new item number in the “Copy to Item/Part” field.

4. Click the “Copy” button to complete the copy or click “Cancel” to cancel the copy
operation.

5. If the target item already has a bill of materials you will see a pop-up that says,
“The Copy To Item already has a Bill of Materials, do you want to replace it?” If
you click “Yes”, the bill of materials for the “Copy To” item will be deleted and
replaced with the bill of materials from the item/part displayed and the screen
will display the new “Copy To” item bill of materials. If you click “No”, the
operation is cancelled.

Using the Bill of Materials Tree
To use the BOM tree, perform the following steps:
1. Display the bill you wish to view. See “Displaying a Bill of Materials” above.
2. Where you have the list of applications or the “Nav Tree” (default is on the left

side of the screen), there are two tabs at the bottom. One says “Nav Tree”, the
other says “Trees” and will flash briefly when a bill of materials is displayed.
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Click the “Trees” tab. You will see folders similar to a file directory. Each folder
represents a component on the bill.

Click any of the folders to view the components for that item. You can collapse a
folder by clicking the minus sign (-) next to it. A dot indicates there are no
components for the item.

Click the “Nav Tree” tab to return to the application list.
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Explosion Screen

Use this screen to display the item components from which an item is composed. You can
display the data in two different views:

Single Explosion

Indented Explosion

Current Item Group

Field

Item/Part

Type

Description

Unit of Measure

Revision Level

Display Date

Shows the first level/immediate components from
which an item is composed.

Shows the components at all levels from which
an item is composed.

Explanation

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

The type helps further define an item by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Defines how the item is counted or measured. Some
examples of units of measure are “Bag", "Carton", and
“Feet".

An item may be revised several times. This field displays
the current revision level of this item. The revision level
is entered on the Item Definition screen under Shared
Applications and is informational only.

Can be used to display the bill of materials as of a
particular date either past or future. Can be used to
verify effectivity dates on components in the bill.

Component Table (Components, Description, Change Control, and Reference Designator

tabs)
Column
Row

Level

Explanation
The line number of the row in the table.

A number indicating the level at which the component is
found in this Bill of Material. The number zero (0) is the
end product (highest Level). There is no limit to the
number of levels. Parentheses () around the level
indicate a recursive item (an item that is used as a
component on itself either as an immediate component
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Prefix

Component

Suffix

Quantity

Unit of Measure

Component Type

Description

Manufacture Status

Engineering Status

Change Order

Engineering Revision

Start Date

End Date

Reference Designator

or as a component of another component).

Unique identification of a component in this Bill of
Materials. The Prefix may be used to sequence the
component within the Bill of Materials or to allow
multiple entries for the same component.

Unique identification of an item that is a component of
another item on a Bill of Materials. This component
identification can be pre-defined using Item Definition
screens, but it is not a requirement that the component
be pre-defined.

Unique identification of a component in this Bill of
Materials. The Suffix may be used to sequence the
component within the Bill of Materials or to allow
multiple entries for the same component.

This field is the quantity required for one unit of the
parent Item/Part.

Defines how the item is counted or measured. Some

examples of units of measure are "Bag", "Carton", and
“Feet".

Information indicating what type of component this is.
Some examples of component types are “Assembly”,
“Industrial Supplies”, and “Tool”.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Status of the Manufacturing Bill of Material for the
component, either Active or Inactive.

Status of the Engineering Bill of Material for the
component, either Active or Inactive.

Most current engineering change number for this item.
User entered for informational only.

Most current engineering revision level for this item.
User entered for informational only.

Date this component will become effective on this bill of
material.

The last date this component will be effective on this bill
of material.

Indicates where this component is used on the parent
item. For example, it can refer to a number or letter on
a diagram or it can be the name of a component on a
printed circuit board. You can enter multiple reference
designators separated by commas in this field.
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Message Line

Field

Message

Explanation

Displays information about the current status of the
screen including error messages.

Accessing the Explosion Screen

1.

Click the plus (“+) next to “Inventory” or double-click % “Inventory” in the
“NavTree”.

_Or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
Click “Bill of Materials”. The “Bill of Materials” screen is displayed.

If there is an item or part number in the “ltem/Part” field, the bill of materials for
that item part number is displayed on the main screen.

Click the “Explosion” tab at the top of the main screen.

If there is an item or part number in the “lItem/Part” field, the single level
explosion for that item is displayed on the main screen.
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Using the Explosion Screen

Use these procedures to erase the screen, display a bill of materials explosion for an item,
display the previous bill of materials explosion, and display the next bill of materials

explosion.

Erasing the Screen

To erase the data from the screen click the Erase button ;"f located on the toolbar.

Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the
screen in preparation for another operation.

Displaying a Bill of Materials Explosion

To display a bill of materials explosion, perform the following steps:

1.

2.

Enter an item or part number in the “ltem/Part” field.
Click the Open (Display) button & |ocated on the toolbar or hit the Enter key.
The bill of materials is displayed on the main screen.

Click on either “Single Explosion” or “Indented Explosion” to view the different bill
of materials displays.

_O r_

Use the Search button # next to the “Item/Part” field, the “Description” field to
select an item number.

Double-click on the “Item/Part” you would like to display in the “Search” screen
table.

The bill of material is displayed on the main screen.

Click on either “Single Explosion” or “Indented Explosion” to view the different bill
of materials displays.

Displaying the Previous Bill of Materials Explosion

To display the bill of materials explosion that precedes the bill of materials explosion
currently displayed, perform the following steps:

1.

2.

Click the Previous button 4 located on the toolbar.
The previous bill of materials explosion is displayed on the main screen. The type

of explosion displayed (single or indented) will be the same as the last type you
displayed.
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Displaying the Next Bill of Materials Explosion

To display the bill of materials that follows the bill of materials currently displayed, perform
the following steps:

1. Click the Next button * located on the toolbar.

2. The next bill of materials explosion is displayed on the main screen. The type of
explosion displayed (single or indented) will be the same as the last type you
displayed.

Tip:  You can use the Next button * as a convenient way to locate the first record

in the database. Start by erasing the screen using the Erase button -€, then
click the Next button ¥ .
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Where Used Screen

Use this screen to display where items are used in bills of materials. You can display the

data in two different views:

Single Where Used

Indented Where Used

Current Item Group

Field

Item/Part

Type

Description

Unit of Measure

Revision Level

Display Date

Shows the items that use this component
directly. Sometimes this is referred to as an
“implosion”.

Shows all the items (by level) that use this
component either directly or indirectly through
other items. Sometimes this is referred to as an
“indented implosion”.

Explanation

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

The type helps further define an item by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Defines how the item is counted or measured. Some
examples of units of measure are "Ounce", "Pound" and
"Hour".

An item may be revised several times. This field displays
the current revision level of this item. The revision level
is entered on the Item Definition screen under Shared
Applications and is informational only.

Can be used to display the where used as of a particular
date either past or future. Can be used to verify
effectivity dates on components in the bill.

Component Table (Item/Part, Description, Change Control, and Reference Designator

tabs)
Column

Row

Explanation

The line number of the row in the table.
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Level

Prefix

Component

Suffix

Quantity

Unit of Measure

Type

Description

Manufacture Status

Engineering Status

Change Order

Engineering Revision

Start Date

A number indicating the level at which the component is
found in this Bill of Material. The number zero (O) is the
end product (highest Level). There is no limit to the
number of levels. Parentheses () around the level
indicate a recursive item (an item that is used as a
component on itself either as an immediate component
or as a component of another component).

Unique identification of a component in this Bill of
Materials. The Prefix may be used to sequence the
component within the Bill of Materials or to allow
multiple entries for the same component.

Unique identification of an item that is a component of
another item on a Bill of Materials. This component
identification can be pre-defined using Item Definition
screens, but it is not a requirement that the component
be pre-defined.

Unique identification of a component in this Bill of
Materials. The Suffix may be used to sequence the
component within the Bill of Materials or to allow
multiple entries for the same component.

This field is the quantity required for one unit of the
parent Item/Part.

Defines how the item is counted or measured. Some
examples of units of measure are "Bag", "Carton", and
“Feet".

Information indicating what type of component this is.
Some examples of component types are “Assembly”,
“Industrial Supplies”, and “Tool”.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Status of the Manufacturing Bill of Material for the
component, either Active or Inactive.

Status of the Engineering Bill of Material for the
component, either Active or Inactive.

Most current engineering change number for this item.
User entered for informational only.

Most current engineering revision level for this item.
User entered for informational only.

Date this component will become effective on this bill of
material.
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End Date The last date this component will be effective on this bill
of material.

Reference Designator Indicates where this component is used on the parent
item. For example, it can refer to a number or letter on
a diagram or it can be the name of a component on a
printed circuit board. You can enter multiple reference
designators separated by commas in this field.

Message Line

Field Explanation
Message Displays information about the current status of the
screen.

Accessing the Where Used Screen

1. Click the plus (“+") next to “Inventory” or double-click % “Inventory” in the
“NavTree”.

_or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
2. Click “Bill of Materials”. The “Bill of Materials” screen is displayed.

3. If there is an item or part number in the “ltem/Part” field, the bill of materials for
that item or part number is displayed on the main screen.

4. Click the “Where Used” tab at the top of the main screen.

5. If there is an item or part number in the “ltem/Part” field, the single where used
for that item is displayed on the main screen.
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Using the Where Used Screen

Use these procedures to erase the screen, display the where used bill of materials for an
item, display the previous where used bill of materials, and display the next where used bill
of materials.

Erasing the Screen

To erase the data from the screen click the Erase button ;"f located on the toolbar.

Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the
screen in preparation for another operation.

Displaying a Where Used Bill of Materials

To display a where used bill of materials, perform the following steps:
1. Enter an item or part number in the “ltem/Part” field.
2. Click the Open (Display) button & |ocated on the toolbar or hit the Enter key.
3. The where used bill of materials is displayed on the main screen.

4. Click on either “Single Where Used” or “Indented Where Used” to view the
different bill of materials displays.

_O r_

1. Use the Search button #4 next to the “Item/Part” field, the “Description” field to
select an item number.

2. Double-click on the “Item/Part” you would like to display in the “Search” screen
table.

3. The where used bill of materials is displayed on the main screen.

4. Click on either “Single Where Used” or “Indented Where Used” to view the
different bill of materials displays.

Displaying the Previous Where Used Bill of Materials

To display the where used bill of materials that precedes the where used bill of materials
currently displayed, perform the following steps:

1. Click the Previous button 1 located on the toolbar.
2. The previous where used bill of materials is displayed on the main screen. The

type of where used bill of materials displayed (single or indented) will be the
same as the last type you displayed.
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Displaying the Next Where Used Bill of Materials

To display the where used bill of materials that follows the where used bill of materials
currently displayed, perform the following steps:

1. Click the Next button * located on the toolbar.

2. The next where used bill of materials is displayed on the main screen. The type of
where used bill of materials displayed (single or indented) will be the same as the

last type you displayed.

Tip:  You can use the Next button * as a convenient way to locate the first record

in the database. Start by erasing the screen using the Erase button -€, then
click the Next button ¥ .
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Summary Screen

Use this screen to display a summarized view of a bill of materials, with the quantity
required for the number of units you specify. Since a component can be used at multiple
levels within a bill of materials, the components are summarized by adding the quantity
from each level to a total for that component. You can display the data in two different
views:

Summarized Explosion Shows all of the item components from which
this item is composed in a summarized list.

Summarized Where Used Shows all of the items where this component is
used in a summarized list.

Current Item Group

Field Explanation
Item/Part A unique identifier assigned to each item. It is the main

key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

Display Date Can be used to display the summarized bill as of a
particular date either past or future. Can be used to
verify effectivity dates on components in the bill.

Description Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Type The type helps further define an item by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Unit of Measure Defines how the item is counted or measured. Some
examples of units of measure are "Ounce", "Pound", and
“Hour".

Revision Level An item may be revised several times. This field displays

the current revision level of this item. The revision level
is entered on the Item Definition screen under Shared
Applications and is informational only.

Quantity This field is the quantity used to compute the total
number of a component required for the number of units
specified.

Summary Table (Components and Description tabs)

Column Explanation
Row The line number of the row in the table.
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Prefix

Component

Suffix

Quantity

Unit of Measure

Component Type

Description

Message Line

Unique identification of a component in this Bill of
Materials. The Prefix may be used to sequence the
component within the Bill of Materials or to allow
multiple entries for the same component.

Unique identification of an item that is a component of
another item on a Bill of Materials. This component
identification can be pre-defined using Item Definition
screens, but it is not a requirement that the component
be pre-defined.

Unique identification of a component in this Bill of
Materials. The Suffix may be used to sequence the
component within the Bill of Materials or to allow
multiple entries for the same component.

This field is the total quantity of the component required
for the number of units specified.

Defines how the item is counted or measured. Some
examples of units of measure are Bag", "Carton" and
"Feet".

Information indicating what type of component this is.
Some examples of component types are “Assembly”,
“Industrial Supplies”, and “Tool”.

Contains information describing the item/component.

This description can be as short as an abbreviation or a
long detailed description of the item/component.

Explanation

Displays information about the current status of the
screen including error messages.
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Accessing the Summary Screen

1.

Click the plus (“+) next to “Inventory” or double-click % “Inventory” in the
“NavTree”.

_or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
Click “Bill of Materials”. The “Bill of Materials” screen is displayed.

If there is an item or part number in the “ltem/Part” field, the bill of materials for
that item part number is displayed on the main screen.

Click the “Summary” tab at the top of the main screen.
If there is an item or part number in the “ltem/Part” field, then the summarized

explosion for that item or part number displayed in the Summary table on the
main screen.
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Using the Summary Screen

Use these procedures to display the summarized bill of materials for an item, display the
previous summarized bill of materials, and display the next summarized bill of materials.

Displaying a Summarized Bill of Materials

To display a summarized bill of materials, perform the following steps:

1.

2.

3.

Enter an item or part number in the “Item/Part” field.

If desired, specify a quantity in the “Quantity” field.

For a Summarized Explosion, click the Open (Display) button & located on the
toolbar or hit the Enter key, or click “Show Summarized” located at the bottom of

the table.

For a Summarized Where Used, click “Show Summarized Where Used” located at
the bottom of the table.

_O r_

Use the Search button # next to the “Item/Part” field, the “Description” field to
select an item number.

Double-click on the “lItem/Part” you would like to display in the “Search” screen
table.

The Summarized Explosion for that bill of materials is displayed on the main
screen.

If desired, specify a quantity in the “Quantity” field.
For a Summarized Explosion, click the Open (Display) button & located on the
toolbar or hit the Enter key, or click “Show Summarized” located at the bottom of

the table.

For a Summarized Where Used, click “Show Summarized Where Used” located at
the bottom of the table.

Displaying the Previous Summarized Bill of Materials

To display the summarized bill of materials that precedes the summarized bill of materials
currently displayed, perform the following steps:

1.

Click the Previous button 4 located on the toolbar. The type of summarized bill of
materials displayed (explosion or where used) will be the same as the last type
you displayed.

The previous summarized bill of materials is displayed on the main screen.
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Displaying the Next Summarized Bill of Materials

To display the summarized bill of materials that follows the summarized bill of materials
currently displayed, perform the following steps:

1. Click the Next button * located on the toolbar.

2. The next summarized bill of materials is displayed on the main screen. The type
of summarized bill of materials displayed (explosion or where used) will be the
same as the last type you displayed.

Tip:  You can use the Next button * as a convenient way to locate the first record

in the database. Start by erasing the screen using the Erase button -€, then
click the Next button ¥ .
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Cost Screen

This screen allows you to perform an indented BOM explosion with cost. It displays the cost
for each component in the bill of materials and totals for the entire bill of materials.

The material cost is rolled up from lower level components so the material cost displayed in
the table for a component may not match the material cost entered for that component on
the Item Definition screen under Shared Applications.

The other cost is not rolled up into the next higher level component; it is displayed as it was
entered on the Item Definition screen under Shared Applications for each component.

“Total Material Cost” is calculated from the rolled up material cost for Level 1 components
only since lower level component material cost has already been added into the level 1
material cost.

“Total Other Cost” is calculated from all of the other costs displayed since other cost can
occur at any level of the bill and is independent of the structure.

“Total Cost” is the sum of “Total Material Cost” and “Total Other Cost”.

“Inventory Cost” is the value entered for the item on the Item Definition screen under
Shared Applications. It is the cost that will be used to calculate the on hand value of
inventory. “Total Cost” and “Inventory Cost” should probably be the same.

If the “Total Cost” and “Inventory Cost” are vastly different, you should examine the bill of
material carefully and decide if there is an error in your bill, component costs, or the

inventory cost you entered for the item.

Current Item Group

Field Explanation
Item/Part A unique identifier assigned to each item. It is the main

key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

Display Date Can be used to display the costed bill as of a particular
date either past or future. Can be used to verify
effectivity dates on components in the bill.

Description Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Type The type helps further define an item by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Revision Level An item may be revised several times. This field displays
the current revision level of this item. The revision level
is entered on the Item Definition screen under Shared
Applications and is informational only.
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Unit of Measure

Total Material Cost

Total Cost

Total Other Cost

Inventory Cost

Defines how the item is counted or measured. Some
examples of units of measure are "Ounce", "Pound", and
“Hour".

The sum of the cost for all the level 1 components in the
Bill of Materials.

The sum of the Total Material Cost and the Total Other
Cost.

The sum of the Other Cost for all of the components in
the Bill of Material.

The inventory cost from the Item Definition screen
under Shared Applications. This value is used to
calculate the total cost of on hand inventory.

Summary Table (Cost, Description, Status, Change Control, and Reference Desighator

tabs)

Column

Row

Level

Prefix

Component

Suffix

Quantity

Explanation

The line number of the row in the table.

A number indicating the level at which the component is
found in this Bill of Material. The number zero (O) is the
end product (highest Level). There is no limit to the
number of levels. Parentheses () around the level
indicate a recursive item (an item that is used as a
component on itself either as an immediate component
or as a component of another component).

Unique identification of a component in this Bill of
Materials. The Prefix may be used to sequence the
component within the Bill of Materials or to allow
multiple entries for the same component.

Unique identification of an item that is a component of
another item on a Bill of Materials. This component
identification can be pre-defined using Item Definition
screens, but it is not a requirement that the component
be pre-defined.

Unique identification of a component in this Bill of
Materials. The Suffix may be used to sequence the
component within the Bill of Materials or to allow
multiple entries for the same component.

This field is the quantity required for the number of units
specified.
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Material Cost

Other Cost

Description

Unit of Measure

Component Type

Manufacture Status

Engineering Status

Change Order

Engineering Revision

Start Date

End Date

Reference Designator

The purchasing or manufacturing cost of the component.
It is calculated from subordinate component material
cost and may not match what was entered in the
component’s Item Definition under Shared Applications.
If it does not match you should verify the Item
Definition material cost and the subordinate
components’ material costs.

Cost incurred at the component level that is not
attributed to purchasing or manufacturing. This can be
overhead, fees, etc. It is retrieved from the Item
Definition under Shared Applications for the component.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Defines how the item is counted or measured. Some
examples of units of measure are Bag", "Carton" and
"Feet".

Information indicating what type of component this is.
Some examples of component types are “Assembly”,
“Industrial Supplies”, and “Tool”.

Status of the Manufacturing Bill of Material for the
component, either Active or Inactive.

Status of the Engineering Bill of Material for the
component, either Active or Inactive.

Most current engineering change number for this item.
User entered for informational only.

Most current engineering revision level for this item.
User entered for informational only.

Date this component will become effective on this bill of
material.

The last date this component will be effective on this bill
of material.

Indicates where this component is used on the parent
item. For example, it can refer to a number or letter on
a diagram or it can be the name of a component on a
printed circuit board. You can enter multiple reference
designators separated by commas in this field.
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Message Line

Field Explanation
Message Displays information about the current status of the

screen including error messages.

Accessing the Cost Screen

1. Click the plus (“+”) next to “Inventory” or double-click % “Inventory” in the
“NavTree”.

_Or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
2. Click “Bill of Materials”. The “Bill of Materials” screen is displayed.

3. If there is an item or part number in the “ltem/Part” field, the bill of materials for
that item part number is displayed on the main screen.

4. Click the “Cost” tab at the top of the main screen.
5. If there is an item or part number in the “ltem/Part” field, then the costed

indented bill for that item or part is displayed in the Summary table on the main
screen.

Using the Cost Screen

Use these procedures to erase the screen, display the costed indented explosion for an
item, display the previous costed indented explosion, and display the next costed indented
explosion.

Erasing the Screen

To erase the data from the screen click the Erase button & located on the toolbar.

Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the
screen in preparation for another operation.

Displaying a Costed Indented Explosion

To display a costed indented explosion, perform the following steps:
1. Enter an item or part number in the “ltem/Part” field.
2. Click the Open (Display) button & |ocated on the toolbar or hit the Enter key.
3. The costed indented explosion is displayed on the main screen.

_o r_
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1. Use the Search button #4 next to the “Item/Part” field or the “Description” field to
select an item number.

2. In the search screen, double-click on the “Item/Part” you would like.
3. The costed indented explosion is displayed on the main screen.
Displaying the Previous Costed Indented Explosion

To display the costed indented explosion that precedes the explosion currently displayed,
perform the following steps:

1. Click the Previous button 4 located on the toolbar.
2. The previous costed indented explosion is displayed on the main screen.
Displaying the Next Costed Indented Explosion

To display the costed indented explosion that follows the explosion currently displayed,
perform the following steps:

1. Click the Next button ¥ located on the toolbar.
2. The next costed indented explosion is displayed on the main screen.

Tip: You can use the Next button * as a convenient way to locate the first record
in the database. Start by erasing the screen using the Erase button .é, then
click the Next button .
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Inventory Control

What is Inventory Control?

Inventory control allows you to track items from receipt through shipment for multiple
inventory stocking locations. When other TFG4000 applications are installed they work with
inventory control to maintain on hand balances automatically.

Inventory updates are accomplished by processing transactions which tell the system
everything it must know to maintain the inventory. Rather than updating the on hand
balance directly, you do the following:

1. Select the item and location you wish to change — Note: The item must be pre-
defined on the “lItem Definition” screen under Shared Applications and the
location must be defined under Shared Applications on the “Location” screen
before any inventory activity can be performed)

2. Choose what kind of activity (transaction) you wish to perform — for example:
Ship or Receive

3. Enter the quantity — for example if you are shipping 20 enter 20
4. Save the data

5. The system takes the information and updates the on hand balance, then logs
the transaction history

Each time an inventory transaction is executed, whether manually or automatically, a
history record is written as an audit trail.

It is very similar to the way you update your bank account balance. You do not tell the bank

what your current balance is, you tell them how much you are adding or subtracting from
the current balance. They apply your transaction and tell you what your current balance is.
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Using Shelf-Life for Inventory Control

An expiration date (shelf-life) is one way to separate the inventory logically within a specific
physical location. Many products have expiration dates that indicate when that product has
reached the end of its useful life. The inventory physically looks the same, but can be
separated into many smaller units based upon the date. By entering the expiration date
when a product is received into inventory, you can identify the product to be used before
the end of its shelf-life.

There are a couple of ways you can determine expiration date for inventory:

1. You can create a physical stocking location with an associated expiration date
(shelf-life) for an item and store all items of that type and expiration date in the
same physical location. Use this method when you want to create specific and
discrete physical stocking locations for each expiration date. Make sure you name
your locations so they will sort in the order you want them. For example,
locations XY-2000-03-31 and XY-2000-04-30 or locations AA-01, AA-02, AA-03,
BB-01, BB-02, etc.

2. You can create a physical stocking location then establish an expiration date as
you receive inventory into the location. Unlike method 1, the expiration data is
not associated with the location itself; it is associated with the inventory in that
location. This allows you to use the location over and over with different
expiration dates as needed. It also allows you to store items with different
expiration dates in the same location.

Once you have decided how you want to determine expiration date — either by the name of
the location itself or by an expiration date associated with the inventory — you can process
your older inventory first.

If you use method 1 you should use the Item Inventory screen so the locations are sorted in
the order you need them.

If you use method 2 you can use the Shelf Life Summary screen. The inventory on that
screen is displayed with the oldest expiration date at the top of the list.
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Inventory Control Screens

Inventory Control consists of four tabbed screens that are used to enter, maintain, and view
inventory data. Each screen is used for specific purposes to aid in the entry and
maintenance of inventory.

Item Inventory

Use this screen to control and track the movement of your inventory for one item in multiple
inventory stocking locations.

Location Inventory

Use this screen to control and track the movement of your inventory for multiple items in
one inventory stocking location.

Inventory History

Use this screen to view the movement of your inventory. You can view the adjustment,
cycle count, issuance, scrapping, return, receipt, and shipment of each item with the most
recent activity first.

Shelf-Life Summary

Use this screen to view the shelf-life information for inventory items that have expiration
dates.

Inventory Summary

Use this screen to view the total on-hand inventory for an item or for multiple items based
on selection criteria.
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Inventory Control Screens Explained

Item Inventory Screen

Use this screen to control and track the movement of your inventory for one item in multiple
stocking locations. You can perform the following actions on the inventory:

Adjust (+7/-) Increments the on-hand balance if you enter a
positive Transaction Quantity, decrements if you enter a
negative quantity.

Change or correct the on-hand quantity of an item in a
specific stocking location. You can use a quantity of zero
to put a shelf-life/expiration date on an inventory
location that did not already have one without affecting
the on-hand balance.

Cycle Count (+ 7/ -) Uses the on-hand balance and the transaction
quantity entered to calculate the difference then either
increments on-hand or decrements on-hand.

Enter the quantity that was physically counted in a
location. The system will generate the appropriate
adjustment.

Issue (-) Decrements the on-hand balance.

Disburse/use inventory. Use this transaction type to
indicate you have removed inventory.

Move (-/+) Decrements the on-hand balance in the location
where the inventory is moving from and increments the
on-hand balance in the location where the inventory is
being moved to.

Move inventory from one location to another. Note: You
cannot select a Move To Location unless you have
selected “Move” as the transaction type.

Receive (+) Increments the on-hand balance.

Accept an item into a stocking location.

Return (+) Increments the on-hand balance.

Put inventory into a stocking location indicating it was
taken at some point and now it is being put back.

Return to PO (-) Decrements the on-hand balance.

Remove inventory from a stocking location indicating it
has been returned to the supplier (vendor).
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Scrap

Ship

Current Item Group

Field

Item/Part

Type

Description

Status

Item Cost Total

Reserve

Total Cost

Item Percent

Unit Cost

No Cost

(-) Decrements the on-hand balance.

Discard an inventory item. Use this transaction type to
indicate inventory that was not useable.

(-) Decrements the on-hand balance.

Use this transaction type to indicate inventory has been
sold or shipped.

Explanation

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

The type helps further define an item by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Current status of the item (Active or Inactive)

The total cost of all on hand inventory for an item based
on the inventory cost defined on the “Item Definition”
screen under Shared Applications or average cost that
has been calculated using inventory cost. (The item cost
total is updated each time an inventory transaction is
performed for the item.

The reserve quantity from all Reserved Job Orders for
this Item/Part. (Used only if Job Order Management is
installed)

The total cost of all on hand inventory for all items.

The percentage of the Total Cost (see above) that this
item represents.

The cost amount used to determine the Item Cost Total.
Based on the value in the Cost Method field, it will be
either the Inventory Cost defined on the Item Definition
screen under Shared Applications, or the average cost
calculated over time.

The number of items which do not have cost data.
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Average Cost

Cost Method

The average cost of this item calculated when inventory
is received, counted, and adjusted.

Indicates how total cost is displayed. Current Cost
means the Inventory Cost defined on the Item Definition
screen under Shared Applications is used. Average Cost
means the average inventory cost calculated over time
is used. For more information about Current Cost and
Average Cost, see Initial Setup on page Error!
Bookmark not defined..

Inventory Table (Location, Move Location, Order/Shelf Life, and Tran Description tabs)

Column
Row

Transaction Type

Transaction Quantity

Onhand Quantity

Onhand Quan Orig

Warehouse

Zone

Location

Move To Warehouse

Move To Zone

Explanation
The line number of the row in the table.

Kind of transaction that is to be performed. Used only if
you are performing an inventory transaction.

The number of units that are to be processed for this
inventory transaction for this Item/Part. This quantity
can be negative or positive. Used only if you are
performing an inventory transaction.

The number of units that are on hand in this location for
this Item/Part.

The number of units that were on hand in this location
for this Item/Part before the transaction was begun.

Identification of the Warehouse where inventory is
stored for this Item/Part.

Identification of the Zone where inventory is stored for
this Item/Part.

Identification of the Location where inventory is stored
for this Item/Part.

Identification of the Warehouse where inventory is to be
moved if you are performing a Move transaction. This
column is used only if you are performing a move
transaction.

Identification of the Zone where inventory is to be
moved if you are performing a Move transaction. This
column is used only if you are performing a move
transaction.
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Move To Location

Order Number

Order Type

Expiration Date

Transaction Description

Message Line

Field

Message

Identification of the Location where inventory is to be
moved if you are performing a Move transaction. This
column is used only if you are performing a move
transaction. Note: You cannot select a Move To Location
unless you have selected “Move” as the transaction

type.

Place to enter an order number with which the inventory
transaction will be associated (Must be a valid order
number if Job Order Management, Sales Order
Management, or Purchasing Management is installed).
Used only if you are performing an inventory
transaction.

Type of order the order number represents (Job Order,
Sales Order, Purchase Order or Preventive Maintenance
Order). Used only if you are performing an inventory
transaction.

Date when the inventory will not be usable.
Place to enter a description of the inventory transaction

being performed. Used only if you are performing an
inventory transaction.

Explanation

Displays information about the current status of the
screen including error messages.

Accessing the Item Inventory Screen

1. Click the plus (“+") next to “Inventory” or double-click % “Inventory” in the

“NavTree”.

_O r_

Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.

2. Click “Item Inventory”. The Item Inventory screen is displayed.

3. If there is an item or part number in the “lItem/Part” field, the inventory for that
item is displayed on the main screen.

66



Using the Item Inventory Screen

Use these procedures to display inventory for an item, update inventory for an item, display
inventory for the previous item, and display inventory for the next item.

Displaying Inventory

To view inventory for an item, perform the following steps:

1.

2.

Enter an item number in the “ltem/Part” field, or use the Search button %
next to the “Item/Part” field to select an item number.

Click the Open (Display) button & located on the toolbar.

3. View the inventory information displayed on the screen.

Adding New Inventory

To add new inventory information, perform the following steps:

1.

Enter an item number in the “ltem/Part” field, or use the Search button %
next to the “Item/Part” field to select an item number.

Click the Open (Display) button & located on the toolbar.

Select a “Transaction Type” using the dropdown provided; Adjust, Receive,
and Cycle Count are recommended for entering new inventory.

Enter the quantity you want to add in the “Transaction Quantity” column.
Notice the “OnHand Quantity” column now has the quantity you entered.

Enter or select a storage location in the “Location” column.

Type in text describing the transaction you are performing in the “Transaction
Description” column if desired.

If you have an order that must be associated with this transaction click the
“Order” tab, then enter the order number in the “Order Number” column and
select an order type using the dropdown in the “Order Type” column.

If the inventory must have an expiration date click the “Shelf Life” tab, then
enter or select a date in the “Expiration Date” column.

Click the Save button & located on the toolbar. The on-hand quantity will be
calculated and the transaction you executed can be viewed with the Inventory
History screen.

Note: If you did not pre-define the item, you will receive a message saying the item was
not found and it will ask if you want to “Quick Add” the item. If you click “Yes”, you
will get a little pop-up screen where you can enter some information that will be
used to define the item. Click “Add Item” in the pop-up screen to complete the
process. If you use the “quick add” feature you should go to the Item Definition
screen under Shared Applications to make adjustments to the item definition.
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Updating Inventory — Single Transaction for a Location

To update inventory information using an existing row, perform the following steps:

1.

10.

Enter an item number in the “ltem/Part” field, or use the Search button %
next to the “Item/Part” field to select an item number.

Click the Open (Display) button & |ocated on the toolbar.

In the row for the location you want to update, select a “Transaction Type”
using the dropdown provided.

Enter the quantity you want to add or subtract in the “Transaction Quantity”
column. Notice the “OnHand Quantity” column has been adjusted based on
the quantity you entered.

If you are performing a Move transaction, enter or select the location where
you want the inventory moved in the “Move To Location” column. Note: You
cannot select a “Move To Location” unless you have selected “Move” in the
“Transaction Type”.

Type in text describing the transaction you are performing in the “Transaction
Description” column if desired.

If you have an order that must be associated with this transaction click the
“Order” tab, then enter the order number in the “Order Number” column and
select an order type using the dropdown in the “Order Type” column.

If the inventory must have an expiration date click the “Shelf Life” tab, then
enter or select a date in the “Expiration Date” column.

Repeat steps 3 through 8 for each location you want to update.

Click the Save button ld located on the toolbar. The on hand quantity for
each location you chose is updated. Each location update is a single
transaction and the transaction details can be viewed with the Inventory
History screen.

Updating Inventory — Multiple Transactions for a Location

To update inventory information using a new row, perform the following steps:

1.

Enter an item number in the “ltem/Part” field, or use the Search button &4
next to the “ltem/Part” field to select an item number.

Click the Open (Display) button & located on the toolbar.

In a new row, select a “Transaction Type” using the dropdown provided.
Enter the quantity you want to add or subtract in the “Transaction Quantity”
column. Notice the “OnHand Quantity” column now has the quantity you
entered and it indicates if the quantity will be added or subtracted. Negative
quantities are subtracted, positive quantities are added.
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5. Enter or select a storage location in the “Location” column. Note: Please
verify the location you use matches one that already has inventory for the
item. If it does not match it will be considered a new location and it will be
added.

6. If you are performing a Move transaction, enter or select the location where
you want the inventory moved in the “Move To Location” column. Note: You
cannot select a “Move To Location” unless you have selected “Move” in the
“Transaction Type”.

7. Type in text describing the transaction you are performing in the “Transaction
Description” column if desired.

8. If you have an order that must be associated with this transaction click the
“Order” tab, then enter the order number in the “Order Number” column and
select an order type using the dropdown in the “Order Type” column.

9. If the inventory must have an expiration date click the “Shelf Life” tab, then
enter or select a date in the “Expiration Date” column.

10. Repeat steps 3 through 9 for each transaction you want to perform.

11. Click the Save button [ located on the toolbar. The on-hand quantity
affected by each transaction is updated and details of each transaction can be
viewed with the Inventory History screen.

Reversing a Transaction

All inventory transactions except Cycle Count and Move can be reversed by performing the
transaction again but with the sign on the quantity reversed. To reverse a transaction use
either method for updating inventory above, but enter the quantity you wish to reverse in
the Transaction Quantity column as a negative quantity (or a positive quantity if the original
transaction quantity was negative).

Note that even though a transaction may subtract inventory, the original transaction
quantity is positive; so, for example, if you used a Ship transaction to deduct inventory, the
quantity entered for the transaction was originally a positive quantity, so the reversal must
be negative.

Examples:
Reversing an Issue Transaction
1. Select Issue in the Transaction Type column

2. Enter the original Issue quantity as a negative quantity
3. Enter Transaction Description, Order, and Expiration as needed

4. Click the Save button I located on the toolbar.
Reversing a Positive Adjustment
Select Adjust in the Transaction Type column

1
2. Enter the original adjustment as a negative quantity

3. Enter Transaction Description, Order, and Expiration as needed
4

Click the Save button (= located on the toolbar.
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Reversing a Negative Adjustment

ol A

Select Adjust in the Transaction Type column
Enter the original adjustment as a positive quantity
Enter Transaction Description, Order, and Expiration as needed

Click the Save button & located on the toolbar.

Reversing a Cycle Count Transaction

PONPE

o

6.

Locate the original Cycle Count on the Inventory History screen.

Note the quantity adjusted and whether it was positive or negative.

On the Item Inventory screen, select Adjust in the Transaction Type column
Enter the original adjustment quantity as a negative quantity if the original
adjustment was positive or as a positive quantity if the original adjustment was
negative.

Enter Transaction Description, Order, and Expiration as needed

Click the Save button E located on the toolbar.

Reversing a Move Transaction

1.

2.
3.

4.
5.

In the location row where inventory was moved “To”, select Move in the
Transaction Type column.

Enter the original move quantity in the Transaction Quantity column.

Enter or select the location where you want the inventory moved to now using
the columns on the Move Location tab

Enter Transaction Description, Order, and Expiration as needed

Click the Save button & located on the toolbar.

Updating Inventory for Components on a Bill of Materials

If an item has a bill of materials and an inventory transaction is performed for the item,
none of the component inventory is affected. To update component inventory for an item
you need to use a job order in the TFG4000 Job Order Management application. The
following are recommended steps:

1.

Enter a job order for the item or, if you have a sales order for the item, build a
job order for the item (See “Building a Job Order” in the Order screen section of
the Sales Order Management Users Guide or “Building Job Orders from a Sales
Order” in the Job Order section of the Job Order Management Users Guide for
more information about building a job order from a sales order)

Verify the job order bill of materials using the “Parts” screen in Job Oder
Management.

Relieve component inventory using the “Picking” screen in Job Order
Management.

Using the Job Order screen in Job Order Management, report the quantity of the
item completed so it will be stored in the inventory location you want.

Now you can perform inventory transactions for the item. The component
inventory was already adjusted accordingly using Job Order Management.

70



Note: For more information about using job orders see the Job Order Management
Users Guide. All manuals are available from any screen with the
Documentation menu located at the top of each screen.
Displaying Inventory for the Previous Item

To display inventory for the item that precedes the item currently displayed, perform the
following steps:

1. Click the Previous button 4 located on the toolbar.
2. Inventory for the previous item is displayed on the main screen.
Displaying Inventory for the Next Item

To display inventory for the item that follows the item currently displayed, perform the
following steps:

1. Click the Next button * located on the toolbar.
2. Inventory for the next item is displayed on the main screen.

Tip:  You can use the Next button * as a convenient way to locate the first record
in the database. Start by erasing the screen using the Erase button -f, then
click the Next button ¥ .
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Location Inventory Screen

Use this screen to control and track the movement of your inventory for multiple items in
one stocking locations. You can perform the following actions on the inventory:

Adjust (+7/-) Increments the on-hand balance if you enter a
positive Transaction Quantity, decrements if you enter a
negative quantity.

Change or correct the on-hand quantity of an item in a
specific stocking location. You can use a quantity of zero
to put a shelf-life/expiration date on an inventory
location that did not already have one without affecting
the on-hand balance.

Cycle Count (+ 7/ -) Uses the on-hand balance and the transaction
quantity entered to calculate the difference then either
increments on-hand or decrements on-hand.

Enter the quantity that was physically counted in a
location. The system will generate the appropriate
adjustment.

Issue (-) Decrements the on-hand balance.

Disburse/use inventory. Use this transaction type to
indicate you have removed inventory.

Move (-/+) Decrements the on-hand balance in the location
where the inventory is moving from and increments the
on-hand balance in the location where the inventory is
being moved to.

Move inventory from one location to another. Note: You
cannot select a “Move To Location” unless you have
selected “Move” in the “Transaction Type”.

Receive (+) Increments the on-hand balance.

Accept an item into a stocking location.

Return (+) Increments the on-hand balance.

Put inventory into a stocking location indicating it was
taken at some point and now it is being put back.

Return to PO (-) Decrements the on-hand balance.

Remove inventory from a stocking location indicating it
has been returned to the supplier (vendor).

Scrap (-) Decrements the on-hand balance.

Discard an inventory item. Use this transaction type to
indicate inventory that was not useable.
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Ship (-) Decrements the on-hand balance.

Use this transaction type to indicate inventory has been
sold or shipped.

Current Item Group

Field Explanation

Warehouse Inventory Warehouse name.

Zone Zone with the warehouse.

Location Inventory location name.

Usage Contains information describing how the location is

used. Some examples of usage are “Receiving”,
“Staging”, “Pallet”.

Type The type helps further define a location by giving it a
classification. Some examples of types are:
"Warehouse", "Finished", "WIP" (Work In Process)

Status The current status of the location, for example “Active”,

“Inactive”, “Quarantine”.

Inventory Table (Transaction, Move Location, Order, Shelf Life, and Trans Description
tabs)

Column Explanation
Row The line number of the row in the table.
Transaction Type Kind of transaction that is to be performed. Used only if

you are performing an inventory transaction.

Transaction Quantity The number of units that are to be processed for this
inventory transaction for this Item/Part. This quantity
can be negative or positive. Used only if you are
performing an inventory transaction.

Item/Part Identification of an Item/Part stored in this location.

Onhand Quantity The number of units that are on hand in this location for
this Item/Part.

Onhand Quan Orig The number of units that were on hand in this location
for this Item/Part before the transaction was begun.

Item Description Contains information describing the item. This

description can be as short as an abbreviation or a long
detailed description of the item.
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Move To Warehouse

Move To Zone

Move To Location

Order Number

Order Type

Expiration Date

Transaction Description

Message Line

Identification of the Warehouse where inventory is to be
moved if you are performing a Move transaction. This
column is used only if you are performing a move
transaction.

Identification of the Zone where inventory is to be
moved if you are performing a Move transaction. This
column is used only if you are performing a move
transaction.

Identification of the Location where inventory is to be
moved if you are performing a Move transaction. This
column is used only if you are performing a move
transaction. Note: You cannot select a Move To Location
unless you have selected “Move” in the Transaction

Type.

Place to enter an order number to which the inventory
transaction will be associated (Must be a valid order
number if Job Order Management, Sales Order
Management, or Purchasing Management is installed).
Used only if you are performing an inventory
transaction.

Type of order the order number represents (Job Order,
Sales Order, Purchase Order or Preventive Maintenance
Order). Used only if you are performing an inventory
transaction.

Date when the inventory will not be usable.

Place to enter a description of the inventory transaction

being performed. Used only if you are performing an
inventory transaction.

Explanation

Displays information about the current status of the
screen including error messages.
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Accessing the Location Inventory Screen

1. Click the plus (“+”) next to “Inventory” or double-click % “Inventory” in the
“NavTree”.

_or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
2. Click “Item Inventory”. The Item Inventory screen is displayed.

3. If there is an item in the “lItem/Part” field, the inventory for that item is displayed
on the main screen.

4. Click the “Location Inventory” tab at the top of the main screen.

5. If there is a location in the “Location” field, the inventory for that location is
displayed on the main screen.

Using the Location Inventory Screen

Use these procedures to display inventory for a location, update inventory in a location,
display inventory for the previous location, and display inventory for the next location.

Displaying Inventory
To view inventory for a location, perform the following steps:

1. Enter a location in the “Location” field, or use the Search button % next to
the “Location” field to select a location.

2. Click the Open (Display) button & located on the toolbar.
3. View the inventory information displayed on the screen.
Adding New Inventory
To add new inventory information, perform the following steps:

1. Enter a location in the “Location” field, or use the Search button &4 next to
the “Location” field to select a location.

2. Click the Open (Display) button i located on the toolbar.

3. Select a “Transaction Type” using the dropdown provided; Adjust, Receive,
or Cycle Count are recommended for entering new inventory.

4. Enter the quantity you want to add in the “Transaction Quantity” column.
Notice the “OnHand Quantity” column now has the quantity you entered.

5. Enter or select an item in the “ltem/Part” column.
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2

If you have an order that must be associated with this transaction click the
“Order” tab, then enter the order number in the “Order Number” column and
select an order type using the dropdown in the “Order Type” column.

If the inventory must have an expiration date click the “Shelf Life” tab, then
enter or select a date in the “Expiration Date” column.

Click the “Description” tab and type in text describing the transaction you are
performing in the “Transaction Description” column if desired.

Click the Save button [ located on the toolbar. The on-hand quantity will be
calculated and the transaction you executed can be viewed with the Inventory
History screen.

Updating Inventory — Single Transaction for an Item

To update inventory information using an existing row, perform the following steps:

1.

10.

Enter a location in the “Location” field, or use the Search button #% next to
the “Location” field to select a location.

Click the Open (Display) button & located on the toolbar.

In the row for the item you want to update, select a “Transaction Type” using
the dropdown provided.

Enter the quantity you want to add or subtract in the “Transaction Quantity”
column. Notice the “OnHand Quantity” column has been adjusted based on
the quantity you entered.

If you are performing a Move transaction, click the “Move Location” tab, then
enter or select the location where you want the inventory moved in the “Move
To Location” column. Note: You cannot select a Move To Location unless you

have selected “Move” in the Transaction Type.

If you have an order that must be associated with this transaction click the
“Order” tab, then enter the order number in the “Order Number” column and
select an order type using the dropdown in the “Order Type” column.

If the inventory must have an expiration date click the “Shelf Life” tab, then
enter or select a date in the “Expiration Date” column.

Click the “Description” tab and type in text describing the transaction you are
performing in the “Transaction Description” column if desired.

Repeat steps 3 through 8 for each item you want to update.

Click the Save button & located on the toolbar. The on hand quantity for
each item you chose is updated. Each item update is a single transaction and
the transaction details can be viewed with the Inventory History screen.
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Updating Inventory — Multiple Transactions for an item

To update inventory information using a new row, perform the following steps:

1.

10.

11.

Enter a location in the “Location” field, or use the Search button #% next to
the “Location” field to select a location.

Click the Open (Display) button & |ocated on the toolbar.
In a new row, select a “Transaction Type” using the dropdown provided.

Enter the quantity you want to add or subtract in the “Transaction Quantity”
column. Notice the “OnHand Quantity” column now has the quantity you
entered and it indicates if the quantity will be added or subtracted. Negative
quantities are subtracted, positive quantities are added.

Enter or select an item in the “lItem/Part” column. Note: Please verify the
item you use matches one that already has inventory in this location. If it
does not match it will be considered a new item for the location and it will be
added.

If you are performing a Move transaction, click the “Move Location” tab, then
enter or select the location where you want the inventory moved in the “Move
To Location” column. Note: You cannot select a Move To Location unless you

have selected “Move” in the Transaction Type.

If you have an order that must be associated with this transaction click the
“Order” tab, then enter the order number in the “Order Number” column and
select an order type using the dropdown in the “Order Type” column.

If the inventory must have an expiration date click the “Shelf Life” tab, then
enter or select a date in the “Expiration Date” column.

Click the “Description” tab and type in text describing the transaction you are
performing in the “Transaction Description” column if desired.

Repeat steps 3 through 9 for each transaction you want to perform.

Click the Save button [ located on the toolbar. The on-hand quantity
affected by each transaction is updated and details of each transaction can be
viewed with the Inventory History screen.

Displaying Inventory for the Previous Location

To display inventory for the location that precedes the location currently displayed, perform
the following steps:

1. Click the Previous button ¥ located on the toolbar.

2. Inventory for the previous location is displayed on the main screen.
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Displaying Inventory for the Next Location

To display inventory for the location that follows the location currently displayed, perform
the following steps:

1. Click the Next button ¥ located on the toolbar.
2. Inventory for the next location is displayed on the main screen.

Tip: You can use the Next button * as a convenient way to locate the first record
in the database. Start by erasing the screen using the Erase button .df, then
click the Next button F .
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Inventory History Screen

Use this screen to view the movement of your inventory. You can view each transaction
performed for an item, with the most recent activity at the top of the list in the table.

Selection Criteria Group

Field

Item/Part

Transaction Description

Transaction

Number of Rows to Display

Start Date

End Date
Advanced
Advanced Group

Field

Pool

Lot Number

Order Type

Order Number

Warehouse

Zone

Explanation

Enter a full or partial item to search history by item.
Use the percent sign (%) for wildcards.

Enter a full or partial description to search history by
description. Use the percent sign (%) for wildcards.

Field for selecting the type of inventory transaction that
was performed (Adjust, Cycle Count, Issue, etc.)

Controls the number of database rows to retrieve during
the query. The default value is 30. The more rows
retrieved, the longer it takes the query to complete.

Use the selection criteria to help control the number of
rows retrieved.

The start date on which to start the retrieval of the data.
The end date on which to stop the retrieval of the data.

Click this button to display more selection options.

Explanation

Enter a full or partial pool to search history by pool. Use
the percent sign (%) for wildcards.

Enter a full or partial lot number to search history by lot
number. Use the percent sign (%) for wildcards.

Field for selecting the type of order for which a
transaction was performed (e.g. Job, Customer,
Purchase, etc.)

Enter a full or partial order number to search history by
order. Use the percent sign (%) for wildcards and use
Order Type to limit the search to a specific order type.

Enter a full or partial warehouse name to search history
by inventory warehouse. Use the percent sign (%) for
wildcards.

Enter a full or partial zone name to search history by
inventory zone. Use the percent sign (%) for wildcards.
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Location

Enter a full or partial location name to search history by
inventory location. Use the percent sign (%) for
wildcards.

Transaction Table (Transaction, Location, Trans Description, Item Description, and Cost

tabs)
Column
Row

Time Stamp

Item/Part

Transaction

Quantity

Warehouse

Zone

Location

Expiration Date

Transaction Description

Order Number

Order Type

Item Description

User ID

Item Unit Cost

Item Average Cost

Explanation

The line number of the row in the table.

Identification of the Date and Time that this transaction
was recorded for this row. This column is in descending
order.

Item number for which the transaction was performed.

Information indicating the Type of inventory transaction
that was performed. Some examples of types are:

"Adjust”, "Receive", and "Ship".

The number of units that were processed for this
inventory transaction for this Item/Part.

Inventory warehouse where the activity occurred.

Zone within warehouse where the activity occurred.
Inventory location where the activity occurred.
Expiration date of when the inventory will not be usable.
The transaction description may contain comments or
other additional information about an inventory

transaction.

Indicates the order that created this inventory
transaction if applicable.

Type of order for which the transaction was executed,
e.g. Job Order, Ship Order, Customer Order, etc. if
applicable.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Identification of the person who performed the inventory
transaction.

The current cost for one unit of the item when the
transaction was performed.

The average cost for one unit of the item when the
transaction was performed.
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Extended Unit Cost Transaction quantity times item unit cost.

Extended Average Cost Transaction quantity times item average cost.

Message Line

Field

Message

Explanation

Displays information about the current status of the
screen.

Accessing the Inventory History Screen

1.

Click the plus (“+™) next to “Inventory” or double-click 2 “Inventory” in the
“NavTree”.

_or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
Click “Inventory Control”. The Item Inventory screen is displayed.

If there is an item or part number in the “Item/Part” field, the inventory for that
item is displayed on the main screen.

Click the “Inventory History” tab at the top of the main screen.

If there is an item or part number in the “lItem/Part” field, the inventory history
for that item is displayed on the main screen.
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Using the Inventory History Screen

Displaying Inventory Transaction History

To view inventory history, perform the following steps (Steps 1 through 5 are optional):

1.

Enter all or part of an item number in the “lItem/Part” field, or use the Search
button # next to the “Item/Part” field to select an item number. Leave this
field blank to view history for all items.

Enter full or partial search information or select search information in the
fields in the Selection Criteria area of the screen or leave fields blank if you do
not want to limit the search.

Enter a Start Date and End Date to specify the range to display in Inventory
History. The date range defaults to 30 days before today’s date in the Start
Date and today’s date in the End Date.

Click the “Advanced” button in the Selection Criteria area of the screen.
Additional selection fields are displayed at the bottom of the screen.

Enter full or partial search information or select search information in the
fields in the Advanced area of the screen or leave fields blank if you do not
want to limit the search.

Click the Open (Display) button & |ocated on the toolbar.

View the Inventory History information displayed on the screen.

If the record you are looking for is not displayed in the table, either increase

the “Number of Rows to Display” or change the selection criteria, particularly
the Start and End dates.
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Shelf-Life Summary Screen

Use this screen to view the shelf-life information for inventory items that have expiration

dates.
Selection Criteria Group

Field

ltem/Part

Start Date
End Date

Number of Rows to Display

Explanation

Enter a full or partial item to search shelf-life items by
item. Use the percent sign (%) for wildcards.

Indicates the oldest expiration date you wish to view.
Indicates the latest expiration date you wish to view.

Controls the number of database rows to retrieve during
the query. The default value is 30. The more rows
retrieved, the longer it takes the query to complete.

Use the selection criteria to help control the number of
rows retrieved.

Summary Table (Shelf Life and Location tabs)

Column
Row
Expiration Date

Item/Part

Onhand Quantity

Description

Type

Unit of Measure

Warehouse

Explanation

The line number of the row in the table.
Date when the inventory will not be usable.

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

The number of units that are on hand in this location for
this Item/Part.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

The type helps further define an item by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Defines how the item is counted or measured. Some
examples of units of measure are "Ounce", "Pound", and
“Hour".

Identification of the Warehouse where inventory is
stored for this Item/Part.
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Zone

Location

Identification of the Zone where inventory is stored for
this Item/Part.

Identification of the Inventory Location where inventory
is stored for this Item/Part.

Message Line

Explanation

Displays information about the current status of the
screen including error messages.

Accessing the Shelf-Life Summary Screen

1.

Click the plus (“+) next to “Inventory” or double-click % “Inventory” in the
“NavTree”.

_or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
Click “Item Inventory”. The Item Inventory screen is displayed.

If there is an item or part number in the “lItem/Part” field, the inventory for that
item is displayed on the main screen.

Click the “Shelf Life Summary” tab at the top of the main screen.

If there is an item or part number in the “ltem/Part” field, the shelf life summary
for that item is displayed on the main screen.

Using the Shelf-Life Summary Screen

Displaying Inventory Shelf-Life Summary

To view shelf-life summary, perform the following steps (Steps 1 and 2 are optional):

1.

Enter all or part of an item number in the “lItem/Part” field, or use the Search
button # next to the “Item/Part” field to select an item number.

Enter a Start Date and End Date to specify the date range to. The date range
defaults to 30 days before today’s date in the Start Date and today’s date in the
End Date.

Click the Open (Display) button & located on the toolbar.

View the Shelf-life Summary information displayed on the screen.

If the record you are looking for is not displayed in the table, either increase the
“Number of Rows to Display” or change the selection criteria.
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Inventory Summary Screen

Use this screen to view the total on-hand inventory for more than one item.

Selection Criteria Group

Field

Item/Part

Item Type

Display Stock Items Only

Product Group

Number of Rows to Display

Explanation

Enter a full or partial item to search inventory by item
number. Use the percent sign (%) for wildcards.

Select an item type to limit the summary to only the
item type selected or leave this field blank for all item

types.

Checkbox to indicate you want to view the inventory
summary only for items defined as “Stock Item” = Yes.
Checked means you want “Stock Item” = Yes only.

Enter a full or partial product group to search inventory
by product group. Use the percent sign (%o) for
wildcards.

Controls the number of database rows to retrieve during
the query. The default value is 30. The more rows
retrieved, the longer it takes the query to complete.

Use the selection criteria to help control the number of
rows retrieved.

Summary Table (Item and Item Description tabs)

Column
Row

Item/Part

Onhand Quantity

Reserve Quantity

Total Cost

Unit Cost

Explanation

The line number of the row in the table.

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

The number of units that are on hand in this location for
this Item/Part.

The reserved quantity from all Reserved Job Orders for
this item/part. (Only used if Job Order Management is
installed)

The total cost of all on-hand inventory for this item
based on value in the “Average Cost” or “Current Cost”
column.

If the column heading is “Unit Cost”, this is the
Inventory Cost entered on the “Cost and Price” screen
under Shared Applications. It is the value of one unit of
the item in inventory.

85



-0r-

Average Cost

Unit of Measure

Stock

Status

Description

Type

Product Group

Message Line

If the column heading is “Average Cost”, this is the
Average Cost calculated using the Inventory Cost
entered on the “Cost and Price” screen under Shared
Applications. It is the average cost of the item over
time.

Defines how the item is counted or measured. Some
examples of units of measure are "Ounce", "Pound", and
“Hour".

Indicates if the inventory for this item is controlled by
the system or not. Yes = inventory controlled item, No
= not inventory controlled item. Items defined as No
can have negative inventory but items defined as Yes
may or may not be allowed to have negative inventory
depending on the Allow_Negative_Inventory system
variable setting.

The current status of the item (Active/lInactive)

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

The type helps further define an item by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

A user defined field for grouping items together. It can

be used to group items together so they can be located
based on their grouping.

Explanation

Displays information about the current status of the
screen.
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Accessing the Inventory Summary Screen

1.

Click the plus (“+) next to “Inventory” or double-click % “Inventory” in the
“NavTree”.

_or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
Click “Item Inventory”. The Item Inventory screen is displayed.

If there is an item or part number in the “lItem/Part” field, the inventory for that
item is displayed on the main screen.

Click the “Inventory Summary” tab at the top of the main screen.

If there is an item or part number in the “ltem/Part” field, the inventory
summary for that item is displayed on the main screen.
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Using the Inventory Summary Screen

Displaying Inventory Summary

To view inventory summary, perform the following steps (Step 1 is optional):

1.

Enter all or part of an item number in the “lItem/Part” field, or use the Search
button @ next to the “Item/Part” field to select an item number.

Enter or select any of the other optional selection fields or leave them blank so
the summary is not limited by those selections.

Click the Open (Display) button & located on the toolbar.

View the Inventory Summary displayed on the screen.

If the record you are looking for is not displayed in the table, either increase the
“Number of Rows to Display” or change the selection criteria.
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Order Point

What is an Order Point?

As inventory is consumed, TFG4000 can determine the inventory level has fallen below a
pre-defined quantity or “order point”. When the order point quantity is reached a
requirement is generated so you will know it is time to order or build more of that item.
When inventory rises above the order point quantity the requirement is automatically
removed.

The order point screens allow you to define the order point quantity as well as the quantity
that should be ordered and track the requirements generated.

When an order point requirement is generated, there is an option to send an email, an
instant message, or both to notify someone of the requirement. Before email or instant
messages can be sent, there are some system administration setup requirements. See the
System Administration Users Guide for more information about configuring TFG4000 for
email and instant messages.

There are two system variables you need to understand before you start using the Order
Point feature of Inventory Management. See the System Variables screen in the System
Administration User Guide for more information about changing the settings for system
variables. The System Administration User Guide is available from the Windows “Start”
menu or from the “Documentation” menu within TFG4000.

Order_Point_Email (default is blank) — Order Point processing sends email when the order
point for an item has been reached. Normally the message is sent to the order point email
address on the Order Point Item screen for the item, but if no email address was defined,
the system sends the message to the default email address defined with this variable. If you
do not want a notification sent to a default email address, leave this variable blank.

Order_Point_IM (default is blank) — Order Point processing sends an instant message
when the order point for an item has been reached. Normally the message is sent to the
order point IM address on the Order Point Item screen for the item, but if no IM address
was defined, the system sends the message to the default IM address defined with this
variable. If you do not want a notification sent to a default IM address, leave this variable
blank.

Order Point Screens

“Order Point” consists of three tabbed screens that are used to enter and maintain order
point data.

Order Point Item
This screen allows you to enter and maintain order point data for an individual item.

Order Point Requirements
This screen allows you to view the requirements generated when inventory fell below the
pre-defined order point quantity for a particular item.

Order Point Summary

This screen allows you to view the requirements generated when inventory fell below the
pre-defined order point quantity for all items.
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Order Point Screens Explained

Order Point ltem Screen

This screen allows you to enter and maintain order point data for an individual item.

Item to Plan

Field

Item/Part

Type

Description

Status

Unit of Measure

Item Planning Parameters

Field

Order Point Quantity

Order Point IM Address

Fixed Order Quantity

Order Point Email

Explanation

A unique identifier assigned to each item/part. It is the
main key for all other item/part data. The identifier can
be a number, a name, or some combination of numbers
and characters.

The type helps further define a line by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Contains information describing the item/part. This
description can be as short as an abbreviation or a long
detailed description of the item/part.

Specifies whether the item/part is active or inactive.

Defines how the item/part is counted or measured for
inventory. Some examples of units of measure are
"Ounces", “Pounds” or "Tons”.

Explanation

Quantity used to determine if a requirement should be
generated for this item. If the total quantity on hand in
inventory for this item falls below this quantity a
requirement will be generated.

Instant Messenger address of the person to be notified
when the order point has been reached. . More than one
address can be entered with a semi-colon (;) between
each address.

The quantity that should be ordered when inventory for
this item falls below the order point quantity.

Email address of the person to be notified when the
order point has been reached. More than one address
can be entered with a semi-colon (;) between each
address.
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Message Line

Field Explanation
Message Displays information about the current status of the

screen including error messages.

Accessing the Order Point Item Screen

1. Click the plus (“+"”) next to “Inventory” or double-click 2 “Inventory” in the
“NavTree”.

_or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
2. Click “Order Point”. The Order Point Item screen is then displayed.

3. If there is an item/part number in the “Item/Part” field, the order point
information for that item/part is displayed on the main screen.

Using the Order Point Item Screen

Use these procedures to erase the screen, display, update, add, delete, display the
previous, and display the next item order point.

Erasing the Screen
To erase the data from the screen click the Erase button -# located on the toolbar.

Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the
screen in preparation for another operation.

Displaying an Item’s Order Point Data
To display an item’s order point data, perform the following steps:
1. Enter an item/part number in the “lItem/Part” field.
2. Click the Open (Display) button i located on the toolbar or hit the Enter key.
3. The item/part order point data is displayed on the main screen.
-or-
1. Use the first Search button #h next to the “Item/Part” field, the “Type” field, the
“Description” field, or the “Status” field to select an item/part number from a list
of items regardless of whether or not they have order point defined. Or use the

second Search button @ next to the “Item/Part” field to select an item number
form a list of items that have an order point defined.
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2. Double-click on the “Item/Part” you would like to display in the “Search” screen
table.

3. The item/part order point data is displayed on the main screen.
Updating an Item’s Order Point Data
To update an item’s order point data, perform the following steps:

1. Display the item you wish to change. See “Displaying an Item’s Order Point
Data” above.

2. Change the desired information on the screen.

3. When done, click the Save button & located on the toolbar.
Deleting Order Point Data for an Item
To delete an item’s order point data, perform the following steps:

1. Display the item whose order point data you wish to delete. See “Displaying an
Item’s Order Point Data” above.

2. Click the Delete button X located on the toolbar.

3. Click the “Yes” button on the “Confirm Action” pop up message. If you do not
want to delete the order point data click “No” on the “Confirm Action” pop up
message.

Displaying the Previous Item

To display the item that precedes the one currently displayed, perform the following steps:
1. Click the Previous button 4 located on the toolbar.
2. The previous item definition is displayed on the main screen.

Displaying the Next ltem

To display the item that follows the one currently displayed, perform the following steps:
1. Click the Next button P located on the toolbar.
2. The next item definition is displayed on the main screen.

Tip: You can use the Next button as a convenient way to locate the first record in
the database. Start by erasing the screen using the Erase button #or
blanking out the “Item/Part” field, then click the Next button *.
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Order Point Requirements Screen

This screen allows you to view and delete order point requirements for an individual item.

Item Data

Field

Item/Part

Type

Description
Status
Requirements Table

Field

Due Date

Type

Quantity

Current Onhand
Status

Description

Delete

Message Line

Explanation

A unique identifier assigned to each item/part. It is the
main key for all other item/part data.

The type helps further define a line by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide.

Contains information describing the item/part.

Specifies whether the item/part is active or inactive.

Explanation

The requirement date; the date the requirement was
posted.

Indicates the kind of requirement displayed e.g.
Independent or Dependent.

The quantity required based on the fixed order quantity
defined in the item’s order point data.

Total quantity of the item currently in inventory.
Current status of this requirement e.g. Active

Information explaining why this requirement was
posted.

Check this box then click Save button = located on the
toolbar to delete this requirement.

Explanation

Displays information about the current status of the
screen including error messages.
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Accessing the Order Point Requirements Screen

1. Click the plus (“+”) next to “Inventory” or double-click % “Inventory” in the
“NavTree”.

_or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
2. Click “Order Point”. The Order Point Item screen is then displayed.

3. If there is an item/part number in the “Item/Part” field, the order point
information for that item/part is displayed on the main screen.

4. Click the “Order Point Requirements” tab at the top of the main screen.

5. If there is an item number in the “ltem/Part” field, the order point requirements
for that item are displayed on the main screen.

Using the Order Point Requirements Screen

Use these procedures to erase the screen, display, delete, display the previous, and display
the next item’s order point requirements.

Erasing the Screen
To erase the data from the screen click the Erase button & located on the toolbar.

Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the
screen in preparation for another operation.

Displaying an Item’s Order Point Requirements
To display an item’s order point requirements, perform the following steps:
1. Enter an item/part number in the “ltem/Part” field.
2. Click the Open (Display) button & located on the toolbar or hit the Enter key.
3. The item/part order point requirements are displayed on the main screen.
-or-
1. Use the first Search button # next to the “Item/Part” field, the “Type” field, the

“Description” field, or the “Status” field to select an item/part number from a list
of items regardless of whether or not they have order point requirements.

2. Double-click on the “lItem/Part” you would like to display in the “Search” screen
table.

3. The item/part order point requirements are displayed on the main screen.
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Deleting an Order Point Requirement
To delete an order point requirement, perform the following steps:

1. Display the item requirement you wish to delete. See “Displaying an Item’s
Order Point Requirements” above.

2. Click the Check box I in the delete column of the requirement you want to
delete. You may select more then one requirement to be deleted at one time.

Click the checkbox I again to remove the deletion flag.
3. Once finished, click the Save button I located on the toolbar.
Note: Once a requirement is deleted, it can no longer be displayed.

Displaying the Previous Item

To display order point requirements for the item that precedes the one currently displayed,
perform the following steps:

1. Click the Previous button 4 located on the toolbar.

2. The order point requirements for the previous item are displayed on the main
screen.

Displaying the Next lItem

To display order point requirements for the item that follows the one currently displayed,
perform the following steps:

1. Click the Next button P located on the toolbar.
2. The order point requirements for the next item are displayed on the main screen.

Tip: You can use the Next button as a convenient way to locate the first record in
the database. Start by erasing the screen using the Erase button - or
blanking out the “Item/Part” field, then click the Next button *.
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Order Point Summary Screen

This screen allows you to view order point requirements for all items.

Item Data

Field

Item/Part

Number of Rows to Display

Summary Table

Field

Iltem/Part

Date

Type

Quantity

Source
Status
Item Description

Requirement Description

Parent Item

Message Line

Explanation

A unique identifier assigned to each item/part. It is the
main key for all other item/part data.

Controls the number of database rows to retrieve during
the query.

Explanation

Item number for the requirement.

The requirement date; the date the requirement was
posted.

Indicates the kind of requirement displayed e.g.
Independent or Dependent.

The quantity required based on the fixed order quantity
defined in the item’s order point data.

Indicates the source of the requirement e.g. Order Point
Current status of this requirement e.g. Active
Additional information about the item.

Information explaining why this requirement was
posted.

The item that caused this dependent requirement to be

generated. The parent item is the item directly above
this item in a bill of materials.

Explanation

Displays information about the current status of the
screen including error messages.

96



Accessing the Order Point Requirements Screen

1. Click the plus (“+”) next to “Inventory” or double-click % “Inventory” in the
“NavTree”.

_or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
2. Click “Order Point”. The Order Point Item screen is then displayed.

3. If there is an item/part number in the “Item/Part” field, the order point
information for that item/part is displayed on the main screen.

4. Click the “Order Point Summary” tab at the top of the main screen.

5. If there is an item number in the “ltem/Part” field, the order point requirements
for that item are displayed on the main screen.

Using the Order Point Requirements Screen

Use these procedures to erase the screen and display order point requirements.
Erasing the Screen

To erase the data from the screen click the Erase button -# located on the toolbar.

Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the
screen in preparation for another operation.

Displaying an Item’s Order Point Requirements
To display an item’s order point requirements, perform the following steps:
1. Enter an item/part number in the “lItem/Part” field.
2. Click the Open (Display) button & |ocated on the toolbar or hit the Enter key.
3. The item/part order point requirements are displayed on the main screen.
-or-

1. Use the Search button # next to the “Item/Part” field to select an item/part
number.

2. Double-click on the “lItem/Part” you would like to display in the “Search” screen
table.

3. The item/part order point requirements are displayed on the main screen.
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Displaying Order Point Requirements for All Items

To display order point requirements for all items, perform the following steps:
1. Click the Erase button . located on the toolbar
2. Click the Open (Display) button & located on the toolbar or hit the Enter key.
3. The order point requirements for all items are displayed on the main screen. If

you do not see the item you are looking for you may have to adjust the value in
the “Number of Rows to Display” field at the top of the screen.
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Advanced Installation

TFG4000 Professional Edition provides some advanced installation functionality such as: font
sizes, system variables, server start up options, BAT file options for single user and multi
user modes.

Please refer to the System Administration User Guide for more information.

Documentation

TFG4000 documentation (in PDF format) is available online at www.tfg4000.com, through
the “Documentation” menu on each screen, and from the Windows “Start” menu. Simply
click “Start”, then “Programs”, then “TFG4000 Professional V1.4", and then
“Documentation”.

Note: PDF files require Adobe® Acrobat® Reader. The reader is available at
www.adobe.com free of charge.

Registration

Quick & Easy Online: After installation, you can go to our web page at www.tfg4000.com
to register the product. Click on “Register” and follow the instructions.

Suggestions

We are eager to improve TFG4000 Professional Edition, and we urge you to tell us what you
think of the software and how it could be improved to better suit your needs. We have
taken many suggestions from our customers and incorporated them into our products. If
you have suggestions or comments, please send an e-mail to tfg4000@fredrickgroup.com.
We want to hear from you!

Services

The Fredrick Group, Inc. offers assistance in data conversion. For more information, contact
The Fredrick Group, Inc. directly by either:

E-mail Send an e-mail to tfg4000@fredrickgroup.com, with ‘Services’ in the subject line.

Phone Call 770-844-8516 between 9:00 AM - 5:00 pm Eastern Time Monday through
Friday (except holidays)
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Support

Note: You must be registered in order to receive support.

Initial Installation Support

The Fredrick Group, Inc. provides free initial installation support via e-mail. Installation
support is available for 30 days, and is activated when you send your first message. You
may also receive installation support by calling, but you must pay the cost of the call.
Technicians are available on a limited basis Monday through Friday (except holidays) from
9:00 am to 5:00 pm Eastern time. The TFG4000 Professional Edition product technical
support number is 770-844-8516.

Pay-As-You-Go Support

Additional fee-based support is available. You pay the cost of the call plus an additional fee.
Credit card information must be provided and confirmed before a call is accepted.
Technicians are available on a limited basis Monday through Friday (except holidays) from
9:00 am to 5:00 pm Eastern time. The TFG4000 Professional Edition product technical
support number is 770-844-8516.

Contact The Fredrick Group, Inc. at tfg4000@fredrickgroup.com for more details.

Other Support Options
Other support options are available.

Contact The Fredrick Group, Inc. at tfg4000@fredrickgroup.com for more details.

Note: Support plans and fees are subject to change without notice.

For more information go to www.tfg4000.com.
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